COMET ANALYSIS SOFTWARE

Cat# 4260-000-CS

For Quantitative Assessment of the Single Cell Gel Electrophoresis Assay
COMET ANALYSIS
SOFTWARE

Cat# 4260-000-CS

Table of Contents

I. Quick Reference Guide 2
II. Introduction 3
III. Precautions and Limitations 5
IV. Materials Supplied 5
V. Materials/Equipment Required but not Supplied 5
VI. Preparation for Quality Analysis 5
   i. Quality Comet Assay Sample Preparation 5
   ii. Quality Image Capture Considerations 7
       Microscope Considerations 7
       Camera Considerations 8
       Image Collection 11
VII. Computerized Comet Assay Analysis 12
    i. New Study Creation 13
    ii. Opening an Existing Study 15
    iii. Image Assignments Using the Well Explorer 15
    iv. Scan Mode 17
    v. Review and Edit 19
    vi. Print and Export Numeric Results & Stats 22
VIII. Tools and Miscellaneous Functions 24
    i. Protocol Creation and Editing 24
    ii. Windows 30
    iii. Wizard Mode 30
    iv. Help Resources 31
IX. Software License Agreement 31
X. References 37
XI. Troubleshooting for Software 38
XII. Related Products Available From Trevigen 39
XIII. Appendix 40
   A. Range & Default Values for Protocol Parameters 40
   B. Comparison Data 41
I. Quick Reference Guide

The Guide described below is written as a Quick Reference. Detailed software instructions are provided in Sections VI-VIII.

Comet Assay Setup:
1. Serially number assay slides, starting at 1 and increasing up to the maximum number of slides in the study.
   - *Detailed experimental records should correspond to each well (ex. A1) by row (A), column (1) and slide.*

Image Capture:
2. Collect images for a given Study using the *same exact equipment and settings* (VI.ii. Image Collection).
   - *Camera should be operated in a fixed gain mode, at the lowest gain setting practical.*
   - *Camera should have a linear response to light input.*
   - *Use longest exposure avoiding saturation of undamaged heads.*
   - *Capture images at 4X or 10X with comet head to left and tail to right.*
   - *Save images as TIFF, JPEG or PNG.*

Software Analysis:
3. Test protocol definition for number of comets found on both an untreated and treated image.
   - *Using the Comet Wizard select Other Tasks> Protocol Definition.*
   - *If necessary, create new protocol definition to increase number of comets found.*

4. Create a new study (Wizard Step 1).
5. Add Images to study using the Well Explorer (Wizard Step 2).
6. Scan images (Wizard Step 3).
7. Review and edit comets (Wizard Step 4).
8. Print or export study results (Wizard Step 5).
II. Introduction

By virtue of an extensive program of research and development, industry leading manufacturing, and quality control, Trevigen offers a unique platform of standardized Comet assay kits, reagents, slides, control cells, electrophoresis instrumentation, and now, state-of-the-art Comet Analysis Software, to simplify assay performance from end-to-end, and assure sensitive, and consistent quantitative results, within, and across successive Comet Assay experiments or screening studies.

The ability of chemical substances such as pesticides, metals, polycyclic aromatic hydrocarbons (PAHs), solvents, gasoline additives, etc. to induce mutations and DNA damage in prokaryotic and eukaryotic cells has created the need to test these chemicals for their genotoxic potential before being used as products, and therefore released into the environment. Conventional methods for evaluating genetic damage, including chromosomal aberration, micronucleus assay and their sister chromatid exchanges are time consuming, resource intensive and require proliferating cell populations. Hence, cost effective and more sensitive test systems have now been introduced for assessing the genotoxicity of chemicals.

The single cell gel electrophoresis or “Comet Assay” is one such state-of-the-art technique for quantitating DNA damage and repair in eukaryotic cells and some prokaryotic cells. This technique is rapid, non-invasive, sensitive, visual and inexpensive compared to conventional techniques and is a powerful tool to study factors impacting mutagenicity and carcinogenicity. It is the only technique that directly measures DNA damage in individual cells and as a result has rapidly gained importance in the fields of genetic toxicology and human and environmental biomonitoring. The Assay measures double strand breaks (DSBs), single strand breaks (SSBs), alkali labile sites, oxidative DNA base damage, DNA-DNA/DNA-protein/DNA-Drug crosslinking, and DNA repair. The following figure summarizes the basic steps in the assay.

The term “Comet Assay,” stems from the comet like appearance that cells with DNA damage take on following the electrophoresis step in the assay, when stained with an intercalating fluorescent dye, and visualized by epifluorescence microscopy.

Cells embedded in low melting point agarose, plated onto microscope slides, are lysed with detergent and high salt to form immobilized nucleoids containing supercoiled loops of DNA linked to the nuclear matrix. Single or double strand breaks in the DNA, caused by damaging agents or conditions, may lead to loss of supercoiling and fragments of DNA freed from the nuclear matrix. When placed in an electrophoretic field, these uncoiled strands and fragments of DNA migrate through the agarose and extend toward the anode of the electrophoresis apparatus. Cells possessing DNA damage, consequently, present a comet like appearance, with a nucleoid head and a streaming tail of damaged DNA. Fluorescent intensities seen in the structures are proportionate to the quantities of DNA present. Cells lacking DNA damage, appear simply as approximately circular fluorescent nucleoid heads with no tail.

The assay can be performed under neutral or alkali conditions, with the neutral version of the assay being principally useful for revealing double strand breaks, and the alkali version providing utility to examination of both single and double strand breaks.
In both versions of the assay, increasing levels of DNA damage lead to increasing amounts of DNA (i.e., increasing fluorescent brightness) being found in the tail, and an increase in the visual tail length. Furthermore, DNA found at the end of the tail is indicative of more damage than an equivalent amount of DNA found at the start of the tail. This is due to the fact that, under electrophoresis, the smaller DNA fragments will migrate through the agarose faster, and therefore further, than will larger DNA fragments; and, a larger number of strand breaks are required to produce a population of small fragments than are required to produce an equivalent mass of larger DNA fragments.

The assay can be scored manually, on an epifluorescence microscope, using visual assessments of tail lengths and simple count based measures, such as the percent of cells exhibiting a tail. However, the speed, range and sensitivity of DNA damage assessments can be greatly enhanced by using a digital camera to transduce the microscopic fluorescent scene into digital images, amenable to automated analysis by a computer, equipped with software capable of generating more sophisticated and powerful quantitative measures of DNA damage, based on a detailed analysis of the distributional properties of the DNA related to each cell.

Trevigen’s Comet Analysis Software provides the computational power to efficiently analyze digital images presenting fields of cells run in the Comet Assay. The Software applies state of the art image processing methods to automatically locate scorable cells, and generate powerful analytic measures on each, to characterize and quantify the degree of DNA damage revealed by the comet assay. In addition to tail length, these measures include:

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tail Area</td>
<td>The total projected area of the comet tail, coupling both tail length and width in a single measure.</td>
</tr>
<tr>
<td>Integrated Cell Intensity</td>
<td>The total fluorescent intensity in the cell, providing an index of total cellular DNA content, useful for cell cycle assessments.</td>
</tr>
<tr>
<td>Percent DNA in the Tail</td>
<td>The integrated tail intensity times 100 divided by the total integrated cell intensity providing a normalized measure of the percentage of total cellular DNA found in the tail.</td>
</tr>
<tr>
<td>Tail Moment</td>
<td>The product of distance and intensity integrated over the tail length for a damage measure combining the amount of DNA in the tail with the distance of migration (severity of damage).</td>
</tr>
<tr>
<td>Tail Moment Arm</td>
<td>The tail moment divided by the integrated tail intensity to measure the average distance of DNA migration within the tail.</td>
</tr>
<tr>
<td>Tail Moment of Inertia</td>
<td>The distance squared times the intensity, integrated over the length of the tail. Similar to tail moment, but providing further emphases on the migration distance for added sensitivity.</td>
</tr>
<tr>
<td>Fragmentation</td>
<td>Measures the relative texture or roughness of the fluorescent cell intensity providing an index of the total fragmentation of cellular DNA in both the head and tail combined.</td>
</tr>
</tbody>
</table>

The Software can rapidly evaluate large numbers of cells, related to each treatment group or screening target in a study, and generate summary statistics based on the corresponding numeric results.

The Software is specially engineered to complement and operate as the computational component of Trevigen’s unique Standardized CometAssay® System, which offers an array of products designed to facilitate sensitive, easy and consistent performance of the comet assay. The power, ease and speed of analysis offered by the Software will be especially appreciated when coupled with Trevigen’s exclusive high throughput CometChip® technology.

This manual provides instructions on the proper use of Trevigen’s Comet Analysis Software. The Software is designed to work
under Microsoft’s Windows™ Operating System (Windows 10, Windows 8/8.1, Windows 7), and this manual assumes that the reader is familiar with the basic features and use of this operating system. Note: The software is the property of Trevigen Inc., and is provided for use under the terms of an End User Software Licensing Agreement. This Agreement may be viewed in section IX of this manual.

III. Precautions and Limitations

Trevigen’s Comet Analysis Software is For Research Use Only. Not for use in diagnostic procedures.

IV. Materials Supplied

- Comet Analysis Software
- Comet Analysis Software Manual

V. Materials/Equipment Required But Not Supplied

- Windows 10, Windows 8/8.1, Windows 7 with latest service pack (32-bit or 64-bit editions);
- Intel or AMD 1.5 GHz or faster processor with SSE2, SSE3 and SSE4 supported (multi-core processor recommended)
- 2 GB RAM (4 GB or higher recommended)
- 2 GB hard disk space (5+ GB recommended)
- 1024 x 768 resolution with 16-bit color display (1366 x 768 resolution with 24-bit or higher color display recommended)
- DirectX 9 or higher compatible audio card with latest driver
- Internet connection required for online features and tutorial videos
- Windows compatible CD/DVD drive for data archive.

VI. Preparation for Quality Analysis

Trevigen’s Comet Analysis Software provides the computational power to efficiently analyze digital images presenting fields of cells run in the Comet Assay. The Software applies state of the art image processing methods to automatically locate scorable cells, and generate powerful analytic measures on each, to characterize and quantify the degree of DNA damage revealed by the comet assay. However, application of even the most advanced software image processing techniques can do little to compensate for poor quality preps or images. Therefore, considerable care and attention must be given upfront to the production of quality Comet Assay sample preparations and to the collection of quality images from such preps, for analysis.

i. Quality Comet Assay Sample Preparation

The quality of results achieved by application of the Comet Analysis Software depends first and foremost on the quality of the sample preparations to be analyzed. Many factors can introduce unwanted variations into comet assay preps, if not properly controlled. Some of the more important factors include the quality and consistency of reagents used, the stability of agarose adherence to the substrates/slides used to support the samples during processing, the level and consistency of temperature across samples during electrophoresis, buffer height, electrode spacing, and the time, level, and consistency of the electric field applied.

Trevigen has solved the problem of controlling for these, and other important, factors, and makes available a novel complete Standardized CometAssay® System. Trevigen’s Standardized CometAssay® System includes CometAssay® kits and reagents, CometSlides™, high throughput CometChips®, alkaline and neutral CometAssay® Control Cells, and a specialized electrophoresis unit. This unit retains test cells in a uniquely configured electrophoretic field permitting consistent DNA migration patterns, which are critical for standardization of the assay. Each lot of the CometAssay® control cells, reagents, CometSlides®, and CometChips® developed by Trevigen are tested and qualified for use in the CometAssay® System. Trevigen is ISO 9001 Quality Assurance Certified.

Trevigen’s CometAssay®, or single cell gel electrophoresis assay, provides a simple and effective method for evaluating DNA damage in cells. The principle of the assay is based upon the ability of denatured, cleaved DNA fragments to migrate out of the
nucleoid under the influence of an electric field, whereas undamaged DNA migrates slower and remains within the confines of the nucleoid when a current is applied. Evaluation of the DNA “comet” tail shape and migration pattern allows for assessment of DNA damage. The Neutral CometAssay is typically used to detect double-stranded breaks, whereas the Alkaline CometAssay is more sensitive, and is used to detect smaller amounts of damage including single and double-stranded breaks.

Trevigen’s CometAssay uses our exclusive CometSlide that is specially treated to promote adherence of low melting point agarose. This eliminates the time consuming and unreliable traditional method of preparing base layers of agarose. The use of Trevigen’s CometSlide shortens assay time and allows the rapid and reliable analysis of large numbers of samples. Slides are available in 2, 3, 20 and 96 well formats.

In comet assays, cells are immobilized in a bed of low melting point agarose, on a Trevigen CometSlide. Following gentle cell lysis, and for the Alkaline CometAssay, samples are treated with alkali to unwind and denature the DNA and hydrolyze sites of damage. For both assays, cells are lysed and the remaining nucleoids are subjected to electrophoresis and subsequent staining with a fluorescent DNA intercalating dye. Trevigen recommends using CometAssay Control Cells (cat# 4256-010-CC) when performing alkaline electrophoresis, and Neutral CometAssay Control Cells (cat# 4257-010-NC) when performing the neutral comet assay, to monitor assay conditions and verify reproducibility between separate runs. SYBR® Gold for DNA visualization by epifluorescence microscopy is recommended.

For high throughput processing, Trevigen’s 96-Well CometChip System can be used in place of the CometSlides. The CometChip is a platform to simultaneously treat and measure DNA damage induced by different treatments, to one or more cell types, on a single slide using the comet assay. The CometChip is an array of spatially encoded micropores patterned on agarose. 96 separate macrowells, each containing ~400 usable micropores, are created by inserting the CometChip into a magnetically sealable cassette. Cells added to each macrowell are deposited by gravity into the micropores. Excess cells once removed, leave a pattern of non-overlapping cells.

Multiple experimental conditions are performed and evaluated in parallel by the addition of different chemicals to respective wells. Once treatment is complete and the CometChip removed from the magnetic cassette, an LMAgarose overlay is added to immobilize the cells within the micropores. When performing the Alkaline CometAssay, the CometChip is immersed in Lysis Buffer for gentle cellular lysis, followed by Alkaline Solution to unwind and denature the DNA and hydrolyze sites of damage. Comets are developed by alkaline electrophoresis.

Whether using the CometSlide or the CometChip, we recommend the use of Trevigen’s CometAssay Electrophoresis System (cat# 4250-050-ES) designed to eliminate known causes of assay variability. The electrophoresis step is performed using an Alkaline Electrophoresis Solution pH > 13, for the alkaline version, whereas a Neutral Electrophoresis Buffer is recommended for the neutral version.

Subsequent staining with SYBR® Gold, a fluorescent DNA intercalating dye, allows visualization of the comet tail shape for assessment of DNA damage by fluorescence microscopy. Note, there are many fluorescent dyes that could potentially be used to label the DNA and Trevigen’s Comet Analysis Software is compatible with each. However, Trevigen recommends the use of SYBR® Gold, as it is an ultra-sensitive nucleic acid gel stain, being 25–100 times more sensitive than ethidium bromide, with demonstrated capabilities to detect as little as 25 pg of DNA. It exhibits >1000-fold fluorescence enhancement upon binding to nucleic acids and has a high quantum yield (~0.6) upon binding to double- or single-stranded DNA. Excitation maxima for dye-nucleic acid complexes are at ~495 nm and ~300 nm and the emission maximum is ~537 nm. SYBR® Gold stain is a proprietary unsymmetrical cyanine dye produced by ThermoFisher Scientific and is supplied as a 10,000X concentrate in DMSO.

Quantitative and statistical data can readily be generated by analysis of the sample preps using Trevigen’s Comet Analysis Software which is designed to analyze digital images captured with a scientific grade digital camera via epifluorescence microscopy. The software automatically locates cells within the images and calculates tail length, percent DNA in the tail, and tail moment, among other parameters.

The CometAssay may be coupled with Trevigen’s FLARE™ (Fragment Length Analysis using Repair Enzymes) Assay that provides the added ability to probe for specific types of DNA damage using DNA repair glycosylases.

Contact Trevigen for more details about analysis of DNA damage and repair.

Note: As slide preps are prepared for a study, the slides should be serially numbered, starting at 1 and increasing up to the maximum number of slides in the study. Detailed records of the experimental conditions corresponding to each well on each slide in the study should also be made for subsequent reference. Wells should be designated by the row (A, B, C,…) and column (1,2, 3,…) in which they appear on the slide.
ii. Quality Image Capture Considerations

To be amenable to computer analysis, quality digital images of the comet assay preps must be captured from each well, at an appropriate microscopic scale. These digital images constitute numeric arrays of measurements relating to the spatially distributed fluorescent intensities presented by the subject samples and reflecting the corresponding distribution patterns of cellular DNA, following electrophoresis and staining of the samples.

The signal-to-noise ratio (SNR) is a widely accepted metric for the quality of the measurements represented in a digital image. The SNR expresses how well the signal of interest is distinguished from background noise. It also relates directly to the level of uncertainty that exists in the measurements, and therefore the degree of confidence that can be placed in the measurement results. SNR is heavily influenced by the characteristics of the overall system, and methods, used to obtain the images. Although this subject can be somewhat complex, there are several key factors to keep in mind: the SNR depends on the signal relevant photon number arriving at the sensor used to capture the image, combined with the sensor’s ability to efficiently and faithfully convert those photon arrivals into digital signals, and how well sources of unwanted noise can be suppressed.

The following will discuss various aspects of the typical equipment and methods used to capture computer analyzable images of comet preps from the aspect of maximizing the SNR, (i.e. maximizing the relevant signal amplitudes, while at the same time minimizing the level and relative effects of sources of noise). The goal here is to give the reader a fundamental understanding of the technology and processes involved, so as to aid the reader in the selection and operation of appropriate equipment for quality comet image acquisition.

Microscope Considerations

The typical setup used to visualize and capture images of comet preps is an epifluorescence microscope equipped with a digital camera, as shown in the diagram. The key functional components of such a system are a high power, UV and near UV rich, light source (generally a xenon arc lamp or a mercury-vapor lamp), an excitation filter, a dichroic mirror (or beam-splitter), an objective lens, an emission filter and a scientific grade digital camera.

The filters and the dichroic mirror must be chosen carefully to match the spectral excitation and emission wavelengths of the fluorophore used to label the DNA. A dichroic mirror is an optical device which will reflect certain wavelengths of light and pass others.

The light source, excitation filter, dichroic mirror and objective lens constitute the illumination (or excitation) arm of the system.

The light source will typically have associated mirrors, lenses and diaphragms, which aid in the effective collection and direction of light from the source to the sample. It is important that these optical elements are all properly aligned and adjusted to provide a bright even illumination within the plane of the sample. The light source itself must be properly maintained and adjusted to maximize brightness and to minimize fluctuations of the source.

Intense broad spectrum light from the source is projected to the excitation filter, where it is filtered to obtain narrow band light, centered at a wavelength (generally in the UV or near UV region of the spectrum) appropriate to excitation of the fluorophore. This light is then directed by the dichroic mirror through the objective lens, where it is concentrated and focused onto the comet
A portion of this light is absorbed by the fluorophore molecules labeling the DNA, causing them to fluoresce and emit light of a longer wavelength.

A fraction of the fluorescence light emitted by the comet sample is then collected by the objective lens and focused through the dichroic mirror and emission filter onto the light sensitive pixel array of the imaging sensor in the camera. The narrow band emission filter helps to eliminate any extraneous (unwanted) light from the true fluorescent signal of interest. The objective lens, emission filter, and camera, therefore, constitute the detection arm of the system.

Note that both the illumination and detection arms of the epi-fluorescent microscope system share the objective lens.

It is important to use an objective designed for fluorescence work, which effectively passes the UV and near UV wavelengths of light required for the excitation of most fluorophores. The optical lens elements in these objectives are typically made of quartz, fused silica, or another specialty glass that has high transmittance at UV and near UV wavelengths. Less expensive objectives designed strictly for bright-field microscopy will frequently have poor light transmission characteristics at these wavelengths, and should not be used.

The numerical aperture (NA) of the objective lens characterizes the solid angle over which it can accept or emit light. For greatest sensitivity it is important to use a quality objective lens with a high NA. The intensity of the excitation light incident on the sample, and hence the effective excitation and fluorescent molecular brightness of the sample (i.e. the average number of photons emitted by the sample per unit time) will change as the square of the NA. Similarly, the light collection power of the objective changes as the square of the NA. Therefore, the emitted light flux reaching the sensor in the camera is proportional to the 4th power of the NA of the objective, at a given magnification. However, the light flux at the sensor is also inversely proportional to the square of the objective’s magnification (M). Therefore, the ultimate number of emitted light photons reaching the sensor in the camera is proportional to (NA)⁴/M².

Higher magnification objectives typically have shorter working distances and higher NA. However, they do not fully benefit from the increased NA, in terms of delivered light flux, because of the inverse relation to the square of the magnification. For comet image capture, the magnification of the objective lens is typically selected to be in the range of 4X to 10X. Consider three different objectives: the first with a magnification of 4X and a numeric aperture of 0.1, the second with magnification 4X and a NA of 0.25, and the third with a magnification of 10X and a NA of 0.40. The second objective will deliver a fluorescent light flux from the sample to the camera sensor that is 39 times that of the first objective, illustrating the benefit of using a higher NA. The third and highest magnification objective, with a significantly higher NA, will deliver a fluorescent light flux that is 41 times that of the first objective, but only slightly (5%) greater than that of the second objective, illustrating the inhibiting effects of increased magnification on light flux.

**Camera Considerations**

As stated earlier, the microscopic scene visualized by the epifluorescence microscope is projected by the objective through the emission filter and focused onto the sensor chip in the attached camera, where the actual digital image capture takes place. It is important that the investigator have a basic understanding of digital camera technology, so that they may evaluate the appropriateness of any particular camera for quality comet image acquisition and have the requisite knowledge to configure and operate the camera employed to best effect.

The camera is typically interfaced to a computer through appropriate high speed communications electronics, which allows for computer control of the camera's various features and capabilities, and permits communication of captured images to the computer for archive and analysis.

The key component in a digital camera is the digital imaging sensor. A digital imaging sensor typically consists of millions of photo-sensitive picture elements or “pixels” fabricated on a semiconductor chip and organized in a planar two-dimensional array. The function of the imaging sensor is to convert the optical (photon) signal emitted from the sample and focused onto the pixel array, during an exposure period, into corresponding (proportionate) electrical signals for conversion into a digital signal by means of an analog-to-digital converter (ADC).

The optical to electrical signal transduction is accomplished by Einstein's photoelectric effect, in which impinging photons interact with the semiconductor material of the sensor, to produce electron hole pairs, sometimes referred to as photo-electrons. During the exposure period the electrons (or holes) produced are captured and stored locally in tiny capacitive potential wells, as an accumulated charge packet. These charge packets are subsequently transferred out to an amplifier, which reads the accumulated charge packets and transforms them into amplified voltages that are presented to an ADC for digitization. Depending on the specific camera design, the ADC may quantize the voltage signals into digital signals with 8 to 16 bits of precision. Generally, the higher the bit depth the better, as this helps to minimize the introduction and magnitude of quantization errors.
The charge generated in a pixel is proportional to the total number of photons striking the pixel. It is a function of the duration of light exposure (integration time), the quantum efficiency of electron hole pair production at the detected wavelength, and most importantly the concentration and light intensity of the fluorophore at the sample. The charge generated is also affected by the size of the pixel. In general, larger pixels can capture more photons and generate more charge. However, larger pixels come at the expense of lower effective spatial resolution.

Lower spatial resolution, however, is not necessarily a bad thing, if matched properly to the spatial needs of the imaging application. Some cameras even offer the flexibility of being able to combine or "bin" groups of pixels locally within the array to create larger "super-pixels" whose aggregate charge can be read out as if from a single pixel. 2 X 2, 3 X 3, and 4 X 4 binning are the most common binning configurations offered. This ability allows the user to trade off spatial resolution for superior radiometric performance. The larger super-pixels offer greater light collection efficiency and dynamic range, while the reduced number of total pixels enables lower effective readout rates, which has benefits in terms of lower read noise, as will be discussed subsequently.

Another important consideration is the fill factor of the camera’s sensor. Due to sensor architecture, the entire surface of the pixels may not be photo-sensitive, as associated circuitry such as shift registers and amplifiers may take up a portion of each pixel’s real estate. The fill factor of an image sensor describes the relation of a pixel’s light-sensitive area to its overall area. Low fill factors reduce the effective light collection size of the pixel, without a corresponding improvement in spatial resolution. In some camera systems, micro-lenses are added to each pixel to better collect photons and focus them onto the photosensitive regions of the pixels, improving the effective fill factor.

Another approach to overcoming low fill factors, is the thinned, back-illuminated sensor. In this type of sensor, the back side of the sensor chip is etched away to create a very thin sensor that can be illuminated from the back side of the chip, thus avoiding any photon blocking ancillary circuitry, and bringing the effective fill factor to 100%. The downside of thinned back-illuminated sensors is that they are very fragile and generally more expensive than non-thinned sensors, because of the added processing required to produce them and lower production yields due to their fragility.

Another important consideration is the fact that there is a limit on the maximum signal amplitude that can be recorded at a pixel during any given exposure period. The full-well capacity (FWC) refers to the charge storage capacity at each pixel. This is the maximum number of electrons it can collect before saturation. Reaching saturation is analogous to a bucket being filled with water to the point of overflow. Generally, larger pixels, like larger buckets, have a greater FWC than small pixels (typically about 1,400 e− for each square micron of pixel area).

Electrons exceeding the FWC of a pixel are lost and cannot be quantified. In some instances, this excess charge can leak into, and contaminate the signals in adjacent pixels, causing an effect known as blooming. Some sensors contain anti-blooming electronics, which act to bleed off any excess charge and prevent corruption of adjacent pixels. As pointed out earlier, spatial resolution is sacrificed for larger pixels and thus higher FWC, which in turn influences the dynamic range of the sensor/camera as discussed below.

A sensor/camera characteristic, directly related to full-well capacity, is the dynamic range. Dynamic range describes a camera system’s ability to simultaneously record low and high intensity signals. For the comet assay a large dynamic range is a major benefit. In practical terms, this means that the weaker signals, often found in comet tails, are not lost in the noise produced by the camera, and the brightest signals, commonly found in comet heads, do not saturate the sensor. Mathematically the dynamic range is defined as the FWC divided by the camera generated noise. The dynamic range improves if the full-well capacity is higher and the noise produced by the camera is lower.

There are two major types of noise produced by camera systems of concern. These are “thermal dark current noise” and “readout noise” or simply "read noise".

Thermal dark current noise is a fundamental noise phenomena seen in all sensors based on the photo-electric effect. Sensor pixels will gradually accumulate charge whether the sensor is being exposed to light or not. This is commonly referred to as dark current or dark current noise, as it is independent of any incoming optical (light) signal. It is caused by random, thermally generated, electrons (or holes) that build up in the pixels. The rate of dark current accumulation depends principally on the temperature of the sensor. With short exposure periods, the effects of dark current may be minimal. However, with longer exposure periods dark current can use up a significant portion of the charge storage capacity at each pixel. Given sufficient time and temperature, dark current will progressively fill every pixel in the sensor up to its FWC.

Managing dark current noise is particularly important for low light imaging applications, like the comet assay, because the weak fluorescence signals often require long exposure times. Fortunately, the rate of dark current noise accumulation can be reduced significantly by cooling the sensor, approximately halving the rate of dark current accumulation with every 8 degrees C of cooling.
A common method of cooling sensor chips, employed by camera manufacturers, is the use of compact multistage solid state thermoelectric heat pumps, based on the Peltier Effect. Using such devices, sensor chips can be cooled by 45 degrees C or more from ambient temperatures, reducing the rate of dark current accumulation by a factor of 100 or more. It is also common for sensor fabricators to mask a subset of pixels, along the edge of the pixel array, with an opaque material, preventing any light input, so that any residual dark current buildup can be isolated and measured. This can then be subtracted from the other unmasked pixels in the array during readout and digitization.

Read noise, on the other hand, originates from the electrical readout circuitry of the sensor/camera involved in amplifying and quantifying the signal into digital values. Read noise is independent of the optical signal and the pixel integration time.

The read noise can generally be reduced by lowering the pixel readout rate, which defines how fast charge is read out from the pixels. Lower readout rates allow amplifiers and associated electronics more time to settle and reset between pixel reads, resulting in more stable, less noisy, performance. Some cameras offer the ability to alter read out rates enabling the cameras to be optimized for a fast readout mode, when dealing with dynamic phenomena, or a slower low noise mode when dealing with a relatively static low light imaging application, such as the comet assay.

A pixel's accumulated charge is read out as a tiny voltage, on the order of microvolts per accumulated electron (or hole). Before being passed to the ADC, the camera amplifies these pixel voltages to levels appropriate for the ADC. All amplifiers will introduce some noise to a signal in the amplification process. Amplifiers can also distort signals, providing different amounts of amplification depending on the input signal level. A well designed amplifier, however, will exhibit high linearity (no distortion) and introduce only minimal noise. The noise that the amplifier introduces will generally scale with the gain of the amplifier, being greater at high gain settings. High gain settings also reduce the effective dynamic range of the camera. Consequently, it is generally beneficial to operate a camera at the lowest gain setting practical.

A few words of caution are appropriate here, with respect to signal amplification.

Some cameras operate in an auto-gain mode in which the camera will dynamically set the gain of the system, according to the average brightness of the scene being imaged, or some other scene specific property (minimum brightness, maximum brightness, etc.). Auto-gain destroys the ability to rationally compare photometric measures obtained in one image to those obtained in another, because it applies a different (and unknown) level of amplification to each image. Note: While, useful for some dynamic imaging applications, auto-gain mode should never be used when employing the camera for a quantitative photometric application, such as comet assay. For quantitative applications, the camera should be operated in a fixed gain mode, at the lowest gain setting practical.

Some cameras also feature a capability called gamma correction, which enables a user to intentionally distort the camera's output signal relative to its input optical signal. For example, by increasing the gamma setting of the camera (gamma > 1), the user can cause the camera to apply more gain to low level optical signals than to high, within a scene. Lowering the gamma setting to values less than 1 causes the reverse to happen. Note: For a quantitative photometric application, such as comet assay, it is very important that the camera provides a linear (non-distorted and proportional) response to input optical signals. In other words, the camera should have a gamma of 1.

There is a fundamental limitation to the performance that can be provided by any camera system, which stems from the quantum nature of light. “Shot noise” (also known as "quantum noise" or "photon noise") describes the random fluctuations in the number of photons detected by a sensor.

This phenomenon is best illustrated by imagining you are trying to catch rain drops in a bucket, during a fixed period of time, in a steady rain. If you now repeat this experiment over and over many times, you would find that the bucket does not capture exactly the same number of drops each time. This is not the fault of the bucket (i.e. the sensor), but is instead the consequence of the discrete and stochastic nature of rain, in terms of droplets. If you were to statistically analyze the results of this rain experiment, you would find that the standard deviation (σ) of the number of drops captured by the bucket, across all the trials, is approximately equal to the square root of the average number of drops captured. In other words, the fluctuations are in accordance with a Poisson probability distribution.

Similarly, with respect to a pixel in a sensor, each photon impact (and production of a photo-electron) constitutes a discrete independent event. Therefore, the charge accumulation at the pixel during any given period of time cannot be precisely predicted; instead the charge accumulation during any given exposure period is governed by a Poisson probability distribution. This is not the fault of the sensor. It is a direct consequence of the discrete and stochastic nature of light, in terms of photons.

Even if a perfect sensor could be produced, where all mechanisms of camera induced noise are absent, the sensor’s optical signal detection would still be “photon noise limited,” as the shot noise remains. Shot noise is inherent to the detection of light.
There is no camera design change or operational trick that can change this fact. Furthermore, higher signal levels will exhibit higher levels of shot noise.

![Shot Noise vs Signal Level](image)

However, consider the following. If the exposure time used to measure a signal is increased, the expected number of photon detections will increase accordingly, and the shot noise will also rise. However, the rate of shot noise increase is slower than that of the signal, as the magnitude of shot noise increases according to the square root of the expected number of events. This means the relative proportion of shot noise, as compared to the detected signal, decreases. In other words, the relative uncertainty in the signal level measurement declines as the signal level rises. Consequently, the Signal-to-Noise Ratio (SNR) improves, resulting in better quality images.

![Relative Uncertainty vs Signal Level for a Perfect Sensor](image)

![SNR vs Signal Level for a Perfect Sensor](image)

**Image Collection**

Quality digital images of the comet assay preps from each well on the various Study slides must be captured, to facilitate analysis. As indicated earlier, these digital images constitute numeric arrays of measurements relating to the spatially distributed fluorescent intensities presented by the subject samples and reflect the corresponding distribution patterns of cellular DNA, following electrophoresis and staining of the samples. The patterns recorded in these images are used by Trevigen’s Comet Analysis Software Application to identify scorable cells and generate corresponding measures of DNA damage.
To aid in the acquisition of quality measures of DNA damage, Trevigen offers the following guidance with respect to image capture from comet assay preps:

1. Use a properly aligned and maintained epifluorescence microscope to visualize assay cells at an appropriate microscopic magnification in the range 4X to 10X.
2. Use an objective magnification that assures at least 20 pixels span the nuclear diameter of a typical undamaged (negative control) cell, to make sure images are captured with an adequate spatial resolution to support the reliable calculation of DNA damage measures from the cells.
3. Use an excitation filter, emission filter, and dichroic mirror with spectral bandpass properties appropriate for the fluorophore used to label the DNA.
4. Use a quality fluorescence grade objective lens with a high numeric aperture to maximize signal (emitted fluorescent light) delivery to the camera sensor.
5. Use a quality scientific grade digital camera that provides a linear response to light inputs for digital image capture.
6. Use a digital camera that has an adequately cooled sensor to reduce thermal dark current noise to minimal levels.
7. Use a digital camera whose sensor is micro-lensed, thinned and back illuminated, or otherwise has an architecture that offers a high effective fill factor, which maximizes the effective light sensitive real estate of the sensor.
8. Use a camera with sufficiently large pixels to provide effective light collection, a reasonable FWC and high dynamic range or, if the feature is available, use binning to configure “Super-pixels” that can accomplish the same.
9. Operate the camera in a fixed gain mode to assure stable image to image performance.
10. Operate the camera at the lowest gain setting practical to help minimize read noise.
11. Use the lowest pixel readout rate offered by the camera to help minimize read noise.
12. Use the longest exposure (integration time) practical, consistent with the brightest cell features (undamaged nucleoid heads) not saturating sensor pixels, to minimize the relative effects of shot noise and maximize SNR.
13. Collect all images for a given Study using the same exact equipment and settings, to assure comparability of results. Comet Analysis software accepts TIFF, JPEG and PNG image formats.
14. During image collection, mount comet slides on the microscope stage such that the comet heads are to the left side of the camera view and the comet tails are extending to the right. Rotation of the camera in its mount may be necessary at the start to achieve proper alignment of the camera with the cells and with the orthogonal motions of the microscope stage.
15. Conventional guidance is that 50 or more cells should be analyzed from each treatment group (Well) to provide reliable statistics, therefore, images providing coverage of 75 or more cells should be acquired to provide a safety margin for possible cell crowding and other factors that may reduce the yield of scorable cells.
16. When collecting multiple images from a Well, avoid overlap between images, to reduce the probability of duplicate scoring of the same cells.
17. When saving captured images, name them in a manner that permits the slide and well from which they were collected to be easily identified. For example, three Tiff format images collected from Well A1 on slide 5 in a Study might be named 5A1_1.tif, 5A1_2.tif, and 5A1_3.tif.

Trevigen’s Comet Analysis Software is designed to accommodate the input of images from a wide variety of digital camera types and brands. It can accept images of various sizes, encoded in the most common digital file formats (Tiff, jpeg, and png) used to communicate and store images. Note: The software, however, does not provide capabilities for direct control of any particular camera type or brand for image capture. This must be accomplished, outside of Trevigen’s Comet Analysis Software, using camera specific image capture software, typically supplied by the manufacturer of the camera employed.

VII. Computerized Comet Assay Analysis

When the Trevigen Comet Analysis Software is installed on a computer, the installation program creates a “Comet” folder on the C drive of the computer’s hard disc. This folder holds the Comet Application executable file (CometApplication.exe) and various other files required for the proper operation of the software. The installation program also creates a “Studies” folder within the Comet folder. The purpose of this folder is to hold folders specific to each comet study analyzed by the software.

The installation program also creates a Comet Application Icon on the computer desktop.
To launch the Comet Application, double left-click on the Application icon. This will open the Application’s Main Window, as shown below.

The Main Window features a graphic of a stylized comet and provides text identifying the Company and Application name, along with contact information for Trevigen. It also provides text references along the bottom of the Window to Trevigen’s innovative CometAssay® Standardized System and CometChip® High Throughput System. Both of which are compatible with Trevigen’s Comet Analysis Software. All the text elements on this Window are active. If the computer has internet access, left-clicking on any of these text elements will open a web browser at the corresponding product information page at Trevigen’s website. These links provide the user with ready access to information, products and protocols that make the conduct of Comet Assays faster, easier, more sensitive and more reliable.

Along the top of the main window is the Title Bar. This displays the Application name, and next to this the name of the currently active Study, if any, is shown. The Title bar also shows information on the number of slides and the Trevigen slide format (2, 3, 20, or 96 Wells) used in the active study.

Immediately below this is the menu bar, which provides access to the various functions and tools that are used when working with the Application. The sections that follow will discuss the use of these various menu options in the context of processing a Comet Assay Study.

i. New Study Creation

When a new Study is created or initialized, the Comet Application will dynamically create a set of folders in which to hold all the Study related data, including all the image files to be analyzed for a given Study (or experiment). The image related folders are organized in a nested structure that logically relates to the number and type of Trevigen CometSlide™ used for the subject Study, as specified by the application user.

Each image file to be analyzed by the software corresponds to an individual well (or treatment region) on one of possibly multiple slides within a given Study. And, each well may have one or more image files related to it. Furthermore, dependent on the slide type used, each slide may have two or more wells (or treatment regions). These are generally arrayed or organized in a row and column structure on the glass surface of the slide. Consequently, any individual well on a particular slide type can be uniquely
identified by specification of the row and column in which it appears. Rows have a letter designation (A, B, C, ...) and Columns have a numeric designation (1, 2, 3, etc...). The figure below shows the various slide types and the arrangement of wells on each.

**Slide Formats**

When the `FILE > New Study` is selected from the main window, the program launches the Define New Study Window, which allows the user to input three Study defining pieces of information: a unique Study Name, the total number of slides in the Study, and the well format of the Trevigen CometSlide™ or CometChip® used. This last input is facilitated by a pull down Slide Type menu which lists each of the different formats as options. The window also requires the identification of a Protocol File by way of a pull down Protocol List menu. A Protocol File lists a set of parameters used by the Application to configure its search and analysis routines. These protocol files will be discussed in more detail later in this manual. When the user is finished inputting the required information, the **Save** button should be left-clicked.

The program will then create a Study (or experiment) specific “Study” folder, named in accordance with the user supplied `<Study Name>`. This folder resides within the “Studies” folder which is found within the “Comet” folder.

Within the newly created Study folder, the program creates a “Slides” folder, which contains a separate folder for each slide in the study. These folders follow the naming convention of `<Slide_Number>` (i.e., Slide_1, Slide_2, ...).

Within each Slide folder, the program creates a separate folder for each well (or treatment region) on the slide, in accordance with the following naming convention: `<Well_Row Letter Designation Column Number Designation>` (i.e., Well_A1, Well_A2, ..., Well_B1, Well_B2, ...).

The “Well” related folders serve as holding places for the images to be analyzed by the program. Once the folders are created for a particular study, the user may directly place images into these folders (independent of the program), as the images are collected (digitally captured), or the user may subsequently move images into these folders, from an intermediate image storage location, with the aid of a programmatic image assignment and review interface referred to as the “Well Explorer”, as detailed in section VII.iii.
Study database files created during subsequent analysis are also stored and accessed from within the Study folder or its nested (Slide or Well) Folders, as appropriate. Thus the Study folder serves to encapsulate all the data related to a specific Study in one convenient place. This facilitates archiving and retrieval of study data by program users.

The newly created Study will become the active Study and its name will be listed in the Title Bar on the Main Application Window.

**Note:** The total data storage needs of individual Studies can be quite large. So at some point, after a number of Studies have been created and analyzed, it may be necessary to move the data related to prior studies out of the studies folder, and onto removable storage media, such as a DVD, or to other archive storage locations, to make room for new studies to be analyzed. This can be most easily accomplished by moving the entire Study folder related to a target Study to the alternate storage location. This will keep all the data related to that Study together. If in the future this data needs to be accessed, the Study folder can be copied back into the Studies folder, in the Comet folder, for processing by the Comet Analysis Application. Study data can also be moved between multiple Comet Analysis Workstations in this manner.

### ii. Opening an Existing Study

The Application user can, also, open a previously created Study by selecting **FILE > Open Study** from the Main Window. The application will launch an Open Study Window, which lists all the available studies found in the Studies Folder. This list also details the date that each study was created and the number of slides in each study. To open a particular Study, left-click on the chosen **Study Name** in the list, to highlight it, and then left-click on the **Open Study** button at the lower right of the window. The Open Study Window will then close, the selected Study will become the active Study in the application, and its name will appear on the Title Bar of the Main Window.

![Open Study Window](image)

### iii. Image Assignments with Well Explorer

Before the Application can analyze the images related to a particular Study, they must be loaded into the appropriate Slide Well folders on the computer, so that they can be accessed by the Application.

Selecting **FILE > Activity > Well Explorer** from the Main Window will cause the application to launch the Well Explorer Window, which enables users to easily review the image file content of the Slide Well folders, related to the active Study. It also provides the capability for a user to browse for and copy the appropriate image files into these folders from other (intermediate) storage locations.
The names of the currently active Study and its assigned Protocol file are displayed near the top of this Window. A button, to the right of these enables the user to Change Protocol file, if desired. When this button is left-clicked, the Application will bring up a sub-window with a pull down list of the available (previously created) Protocol files from which the user may choose a new file.

Immediately below the Study and Protocol file names, on the Well Explorer Window, are two pull down lists that enable the user to select the Slide No. and Well ID of interest. A list box, below these, shows the names of the image files, if any, assigned to the currently selected slide well.

To the right of the list box, a picture of the Trevigen CometSlide™ type (2, 3, 20, or 96 well), used in the active Study, is displayed. In the example shown, this picture is of a 96 Well format slide. A glance at the slide picture provides the user with information on the image assignment status of the various wells on the active slide. Those Well folders corresponding to the currently selected slide, which have one or more images already assigned to them, are indicated on the picture by a dark brown coloring of the associated wells. Those wells, whose folders have no images yet assigned, are shown in white. Furthermore, the currently selected (or active) well is shown in a light brown or cream color. This is the well, for which the image files, shown in the list box on the left, correspond. A legend at the bottom of the window summarizes the different well color treatments and what they mean.

In addition to using the previously discussed Well ID pull down list, to select the active Well, the user can select the active Well by simply left-clicking on the desired Well, on the slide picture. When this is done, the images, if any, then assigned to the Well will be displayed in the list box on the left.

Image files shown in the list box can be examined by left-clicking on the file of interest, to highlight it, and then left-clicking on the Open File Button, located immediately below the image list box. This will cause the default application for displaying image files on the computer to open a window, which will display the image. Similarly, if an image assignment has been made in error and the user wishes to delete an image from the Well folder, the user simply needs to left-click on the Delete File Button, below
the list box, after highlighting the file in the list. **Caution:** The file will be deleted from the current Well folder, so the user may want to make sure the image is backed-up at another location before performing this action.

To add one or more images to a target Well folder, the user simply needs to left-click on the corresponding well on the slide picture. This will make that Well the currently active Well. The user then needs to left-click on the **Browse** Button, found in the lower left region of the Well Explorer Window. This will open a standard Windows ™ browsing window that the user can use to navigate to the intermediate directory location used to store image files during image capture from the Study sample preps.

The user then needs to select the specific image or images, associated with the target well, in the browse window. A single image can be selected by left-clicking on the corresponding file shown in the browse window, or multiple images can be selected by left-clicking on the first of the desired image files and then Shift left-clicking on any additional image files. Once the target images have been selected, the user then needs to left-click on the **Open** button in the browse window. The selected images will then be copied into the targeted Well folder and the image files appearing in the image file list box shown on the left of the Well Explorer Window will be updated.

An alternative method for loading images into their appropriate Well folders is to use the Windows Explorer App to open the intermediate image storage location (directory), and then to drag and drop the image files (one at a time or in groups) directly onto the target wells on the Slide picture shown in the Well Explorer Window. If the intermediate image storage location (directory) is not on the desktop an image copy is made before being moved to the Well folders. **Caution:** Files stored on the desktop are physically moved to the Well folders, consequently, a back-up copy will no-longer exist at the original desktop storage location.

When the user is finished making and reviewing image assignments to the various well folders, he or she can left-click the button marked **"Done,"** to exit the Well Explorer Window.

**iv. Scan Mode**

Once all the images have been loaded into their appropriate Slide Well folders, the Study is ready to be scanned. During scan the Application will systematically retrieve the images from the Slide Well folders and apply state of the art image processing methods to automatically locate scorable cells, and generate powerful analytic measures on each, to characterize and quantify the degree of DNA damage revealed by the comet assay.
Selecting **FILE > Activity > Scan Mode** from the Main Window will cause the Application to launch the “Scan Mode” Window.

This Window identifies the name of the currently active Study and associated Protocol File at the top of the Window. To the right of these, it also provides a **Change Protocol** button to change the Protocol File, if desired. Below these is a table that has one row for each of the Wells to be analyzed. Each row identifies the slide number on which the Well resides, the well name, the path to the Well Folder within the Current Study Folder, the number of Comets found in the Well, and the Well’s Scan Status. Note before actually starting the scan process the number of Comets found will be listed as “0” for each Well, and the associated Scan Status will be listed as “Not Started.” To start the scan process left-click on the **Start Scan** button found at the lower right of the Window.

The Application will then work its way down the table, retrieving and analyzing images from the associated Well Folders. As it progresses down the table, it will display each image, in a “Search Images” Window, as it is analyzed, placing a white box around each valid cell / comet found and updating the “Comets Found” count in the table on the Scan Mode Window. As it analyzes images it will also in some cases place boxes of another color around potential comets. These are cells that were rejected from analysis for several possible reasons: bad cell morphology, cell crowding or overlap that compromises reliable damage measure assessment, cells too close to the image border for proper analysis, or interfering debris. The Application also generates a variety of measures on each valid cell / Comet found, such as Tail Length, %DNA in the Tail, Tail Moment, etc. and writes these values into a database for subsequent review and statistical analysis. When it completes analyzing all the images associated with a particular Well, it updates the Scan Status for that Well in the table to “Completed,” and then moves on to the next Well, if any, in the Study.

When the Application is finished analyzing all the images in the Study, the user can review the cells / Comets found on each image if they desire. By left-clicking on the row corresponding to the Well of interest in the Scan Mode Window, the set of images related to that particular Well can be called-up in the Search Images Window. Each separate image related to the selected Well will have its own tab along the top of the image display area of the Window. By left-clicking on these image tabs the image of interest can be selected for display. Found valid cells / Comets will be marked with a white box.
v. Review and Edit

Selecting **FILE > Activity > Review and Edit** from the Main Window will provide the user with access to a group of windows used in the review and editing of the comet analysis results. The primary windows in this group include:

1. The Review and Edit Window,
2. The Numeric Results Window,
3. The Review Comets Window,
4. The Search Images Window, and
5. The Edit Comet Window.

The first three of these windows open simultaneously when the user enters the Review and Edit activity. They work in conjunction with each other to allow a user to systematically and efficiently review all the comet data generated during the analysis of a study. Actions performed on any one of these windows generally effects the range or focus of information displayed on the others.

The Review and Edit Window provides a summary table that lists the number of comets found (and analyzed), in each well, on the various slides in the active Study. It is the Window used to navigate between Wells, when reviewing the analytic results produced in Scan Mode. Left-clicking on and highlighting a row in the table, corresponding to a particular Well in the Study, results in that Well’s data being displayed in the companion windows. The user can also advance forward or backward through the successive Wells by left-clicking the **Next Well** and **Previous Well** buttons near the top left of the Window. As will be discussed further, below, using the companion windows, specific comets can be excluded from consideration, if there is a problem, such as an error in the identification of a valid Comet by the Application. When a comet is excluded, the count in the table column labeled “Comets Included” is
decremented. The table also has a column that lists the “Review status” of each Well. When a user is finished reviewing and editing, as appropriate, all the comets corresponding to a particular Well, he or she can use (left-click) the “Mark Well” button to change the Review Status of the Well from “Not Started” to “Completed.” If a Well is marked as complete in error, the user can use the same button to unmark it. There is also a button to Mark all Wells as complete, if desired. Left-clicking the “Exit Review” button in the lower right corner of the Window, or left-clicking on the X in the upper right corner will close the window and cause all the companion windows in the Review and Edit activity to close.

The quantitative measures of DNA damage generated from each comet in the selected well are displayed in a table on the Numeric Results Window. Each cell analyzed, within the currently selected Well, corresponds to an individual row in this table. Left-clicking on a row in this table results in that row being highlighted and the corresponding comet image in the Review Comets Window being selected and highlighted in green. If the Search Images Window (discussed previously in the Scan Mode section) is open, the corresponding cell on the original image will also be highlighted by a bold white box. The Search Images Window does not launch automatically, when entering the Review and Edit activity. It can be launched at the user’s option by way of the Windows item on the menu bar at the top of the Main Window.
The Review Comets Window shows images of each of the comets analyzed within a selected Well. Left-clicking on one of these images will make it the currently selected comet, as designated by a green highlight box that surrounds the image. The corresponding row in the Numeric Results Window and comet in the Search Images Window will also be highlighted, if these Windows are open. The comet images shown in the Review Comets Window are displayed along with markers, which delineate the comet head and tail positions, used in generating associated measures of DNA damage. The start of the head has a white marker. The end of the head (or start of the tail) has a red marker. And, the end of the tail has a green marker. The user can edit the positions of the head end and tail end markers, if in the user's opinion these need adjusting.

To accomplish this, the user can double left-click on the comet to be edited or select the "Show Edit Comet Window" option from the Edit Mode menu found at the top left of the Review Comets Window. This will cause the Edit Comet Window to be launched, which shows an enlarged image of the selected comet, together with the subject markers. On this Window the user can make adjustments to the head and tail marker positions, by left-clicking and dragging the markers to their desired positions. When this is done the measures of DNA damage for the comet are automatically recalculated and updated in the Numeric Results Window to reflect the new marker positions. A check mark will also be placed in the table row under the column labeled "Edited," to show that the measures are the result of an edited tail. Selecting "Show Intensity Profile" from the File menu on the Edit Comet Window will cause an intensity profile plot to be superimposed on the enlarged comet image. The Edit Comet Window also provides the capability to alter the color mapping of the comet image, by way of the slider control on the left side of the Window. Both capabilities can be helpful for assessing proper marker positions. The File menu on this Window also has an option to return the marker positions to their original positions (Restore Scanned Values) determined in Scan Mode.
The Review Comets Window also provides the ability to completely exclude specific comets from the analysis results, if the object shown is not a valid comet or has some other problem requiring its exclusion. This can be accomplished by right-clicking on the comet to be excluded. A red X will appear over the image to show that it has been excluded. A check mark in the “Excluded” column on the Numeric Results Window will appear in the corresponding row to show that the comet is excluded. Right-clicking on a comet that has already been excluded will toggle it back to an included status. This same toggling action between exclude and include can also be accomplished from a Toggle Include Exclude option in the Edit Mode menu at the top of the Review Comets Window.

The comet images viewed in the Review Comets Window can be displayed with intensity profile plots superimposed, if desired by the Application user. To accomplish this, the user needs to select Show Intensity Profile from the Edit Mode menu near the top left of the Review Comets Window.

The user can copy the image of the currently selected comet shown in the Review Comets Window by selecting Edit > Copy Image to Clipboard, from the Main Window. The selected comet image can then be pasted into another application, such as Microsoft Word or Excel. Similarly, the numeric results (damage measures) related to the currently selected comet can be copied to the clipboard by selecting Edit > Copy Measure to Clipboard, from the Main Window.

vi.  Print and Export Numeric Results & Stats

Selecting FILE > PRINT OR EXPORT results in launching of the Generate Report Window.

The Generate Report Window, shown below, provides the capability for the user to print out hardcopy reports and export data over the clipboard to an Excel Spreadsheet or other statistical package. In the top half of the Window the user can left-click to toggle check boxes to specify the specific measures to be included in the report. In the lower half of the Window the type of data to be included in the report can be specified. At the user’s option, the reports can include the raw comet by comet quantitative measures selected and/or summary statistics related to each well. The summary statistics include the minimum, maximum, median, mean, and standard deviation of the selected measures. The Protocol settings can also be included in the report printed or exported over the clipboard. Data can also be exported for individual measures to an Excel spreadsheet, pre-formatted for box-plot processing by Analyse-it, a third party statistical analysis add-on to Excel.
When the Print button is left-clicked, the Application opens a standard printer window, which allows the user to select the printer to use, set printing preferences, specify the number of copies, etc. before finally printing the specified report.

When the Export button is left-clicked, the Application copies the specified information to the computer clipboard and puts up a message when the action is complete. The user must then open a destination application, such as Microsoft Excel, and paste the data into the application. The figure below shows a raw data report corresponding to a single Well for a simple test Study that was exported to Excel.

<table>
<thead>
<tr>
<th>Study: TestStudy01</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol: TREV-4X</td>
</tr>
<tr>
<td>Number of Slides in Study: 1</td>
</tr>
<tr>
<td>Number of Wells Per Slide: 2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Raw Data Summary for Slide: 1 Well: A1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comet Id</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>
VIII. Tools and Miscellaneous Functions

i. Protocol Creation and Editing

A Protocol File lists a set of parameters used by the Comet Analysis Application to configure its search and analysis routines.

The Application uses a multi-dimensional classification model to distinguish scorable comets from other (non-target) objects found in comet assay images. The individual analytic dimensions of the classifier derive from characterizing measures acquired on objects found in the images, by the systematic application of a variety of mathematical image processing techniques. These techniques seek first to partition objects of potential interest from the background. They then derive a number of quantitative measures, which serve to characterize the found objects in terms of the various dimensions of the classifier. Quantitative limits, related to each analytic dimension, then allow the finding routines to classify a candidate object as either a scorable comet or a non-target object.

While the total process is rather complex, the underlying classification concept is simple to understand. The Application basically asks and answers questions such as: Is this object that I found too small to be a comet? Is it too big? Is the long axis of the object oriented in a direction consistent with the direction of electrophoresis? Is the object’s shape consistent with the expected shape of a comet? Is the object essentially symmetric about a horizontal line drawn through its center? By asking and answering such questions, the Application is able to systematically sieve through the objects found on each image and classify them as potentially scorable comets, or as non-target objects to be rejected from further consideration. The objects judged to be consistent with the characteristics of comets are passed on to additional software routines, which analyze and quantify the associated distribution of fluorescent intensities and derive various measures of DNA damage.

For the most part, the parameters specified in a Protocol file serve to define the quantitative decision points or limits on the various classification dimensions. In other words, they specify things like, how small is too small to be a comet, or how symmetric must an object be to be consistent with being a comet.

The parameters in a Protocol file can be divided into two basic categories: parameters which are scale dependent, and parameters which are scale invariant. The scale invariant parameters are very stable and only need to be adjusted in rare circumstances. The scale dependent parameters, however, are sensitive to factors such as the electrophoresis conditions, objective magnification of the microscope, and the digital camera’s sensor array type, size and resolution. For this reason, the Comet Analysis Software is equipped with a utility for making adjustments to existing Protocol files to define and save new files. These new Protocol files can then be called up, when appropriate, to configure the search and analysis routines of the Application. To launch this Protocol Definition utility, the user must select Tools > Protocols Definition from the Main Window.

The Application will then bring up a window which allows the user to select an existing protocol file to modify, from a pull down Protocol List of the Protocol files available on the system. Note: The Comet Analysis Software comes supplied with a number of pre-defined Protocol files. These files relate to objective magnifications of 4X and 10X, for both alkali and neutral comet assays. These Protocols were optimized for a 3.3 megapixel camera with a 2048 X 1536 pixel sensor array and a 3.45 X 3.45 micron pixel size. After selecting the desired file to be modified the user should left-click on the OK button at the lower right of the Window. This will cause the Application to launch the Protocol Definition Window, as shown below:
This Window displays the name of the selected Protocol File near the top left of the Window. If the selected file is one of the pre-defined “Built In” Protocols discussed above a check will be shown in the box next to the words “Built In” just below the Protocol name, otherwise the box will be empty. Below the box will be shown two tabs. Left-clicking on the tab labeled General will cause the Window to display the various scale dependent parameters, as shown above. We will discuss these parameters shortly, but first let examine what is displayed when the Advanced Tab is left-clicked, as shown below.

With the Advanced Tab selected the Window displays the various scale invariant parameters. The default values for these parameters have been optimized through extensive testing by Trevigen, and they should generally not be changed unless under consultation with Trevigen technical support personnel. If by accident these parameters do get changed, there is a button that the user can left-click to Reset Default values. The single parameter under the advanced tab which can be changed without guidance from Trevigen technical personnel is the parameter labeled Fluorophore’s Spectral Region. Radio button controls allow the user to specify whether the fluorophore being used to label the DNA in their Comet Assays emit light in the Red, Green, or Blue region of the spectrum. The default setting is Green, as this is the region in which the recommended fluorophore, SYBR® Gold, emits fluorescence. This information is needed to guide proper color channel selection when processing images from a color camera. This setting has no effect if the camera being used is monochrome.
Let’s now return our attention to the scale dependent parameters displayed when the General Tab is selected. These parameters define a search box size that is used when looking for comets in images. They also define size criteria such that objects too small or too large to be comets can be quickly eliminated from consideration. Proper setting of these parameters depends on the apparent scale of comets as seen by the user’s camera at a chosen objective magnification. Different cameras may see comets scaled differently, at the same microscope objective magnification, as a result of differences in the pixel count and array size of the cameras’ sensors. The easiest way to adjust for such camera differences is to measure a typical (average sized) undamaged comet head in an image captured with the subject camera at the chosen magnification. The Application can then automatically compute appropriate parameter values based on this measurement. The Define Protocol Window, therefore, has a button labeled “Measure Head,” which when left-clicked will launch a Wizard message box which will walk the user through the head measurement process.

The initial Wizard message instructs the User to click on a button to Select Image… a representative negative control image.

Doing so will cause a browser window to be launched so that an appropriate image can be identified and selected. When this is done the user should click on the Open button.
Once **Open** has been clicked, the Wizard will instruct the user to select a representative cell (Comet head) by first clicking on the **Select Cell** button. This will cause the selected image to be displayed. The user then needs to identify an appropriate cell in the image and left-click on the center of the head (cell nucleus).

Once this is done, an enlarged image of that cell will be displayed with two markers. The user should then drag the markers so that they align with the left (red) and right (green) edges of the head, as shown below and then left-click on the button labeled **Done**.

The Wizard will then report on the measured head width and the newly calculated values for the various scale dependent parameters, as shown below. To accept these values the user clicks on the **Finish** button. To repeat the measurement process, the user can click on the **Back** button.
Once the user clicks on Finish, the Wizard message box will close and the parameters will be updated in the Protocol Definition Window.

The new Protocol parameter set can be tested against one or more images by using the “Test” button at the lower left of the Define Protocols Window. Clicking on this button will cause a browse window to launch, from which the user can locate and select an image for testing purposes. When the user clicks Open on the browse window, the selected image will be displayed and the comets found on the image will be marked by white boxes, as show below. A message box will also be displayed, which reports the number of comets found on the image.
Note: The user is not locked into the computed parameter values. The user can fine tune the various parameters shown in the Define Protocol Window by directly typing new values into the parameters’ numeric display fields. For example, if in reviewing test images, the user feels that the box size used in searching for comets is too wide, the user can type in a smaller width specification and then run a test to see how the new value performs. Appendix A provides guidance on the reasonable range and default values for each of the parameters listed in the Define Protocol Window.

The user can use the “Save as” button, to name and save the parameter settings in a new Protocol File, once suitable performance is achieved on the test images, so that they can be retrieved and applied to a full study at a later time. The ability to import another previously saved Protocol File for review and refinement is provided by the “Open” button. The “Save” button allows the user to save a refined/updated protocol file under its prior name. And, the “Delete” button allows the user to delete an existing protocol file.

Finally, the “Cancel” button allows the user to exit the interface when he or she has completed setting up Protocol Files. Pressing this button will also close any Test Image Window that is then open.
ii. Windows

The Windows menu item found on the Main Window, provides the user the capability to reopen certain windows after they have been closed. This menu item is primarily used in the Review and Edit activity where multiple interactive windows are simultaneously active. While in the Review and Edit activity, an Application user may want to temporarily close down one or more of the active Windows to reduce screen clutter or to focus specifically on an individual task. The Windows menu item allows the user to reopen these windows as appropriate. The specific windows supported by this item are the Numeric Results Window, the Comet Review Window, and the Search Images Window.

iii. Wizard Mode

From the Tools menu on the Main Window, Wizard Mode can be turned on or off. Wizard Mode provides access to the Comet Wizard, who can be a very helpful fellow.

The Comet Wizard is an artificially intelligent assistant that helps Application users logically navigate the Trevigen Comet Analysis Software. The Wizard monitors everything that is done with respect to the creation, analysis, review, editing and reporting of each Study on the system and pops up at appropriate times to recommend to Application users what the logical next step is in the processing of each Study. Operating with Wizard Mode on is particularly useful to users new to the Application. However, many seasoned users will also find the Comet Wizard useful as it provides shortcuts to access most of the key functions of the Comet Analysis Software.

A typical Comet Wizard message is shown below.

In this example, the Wizard noticed that the user had not finished reviewing (and editing, if needed) all the results generated in a prior Scan Mode Analysis of the Study images. The Wizard is therefore recommending that the user reenter the Review and Edit area of the Application to complete the task. If the user wishes to follow the Wizards advice, all he or she needs to do is left-click the Yes button, and the Wizard will immediately take the user to the proper location in the Application to complete the task. However, if the user wishes to do something else, he or she can left-click on another task in the Wizard Messaging Window and the Wizard will take the user to the appropriate location in the Application to complete that task. All the major tasks necessary for processing a Study are listed in the lower left of the window, in their logical order of performance. The user can also easily navigate to the Application area used to edit an existing or define a new Protocol File. The user can even Exit Comet Application from here.
The user can also left-click on the Close Wizard button, which will leave the Application in Wizard Mode, but will close the current Wizard Message Window. The user can then use the standard menu structure of the Application to accomplish whatever task he or she wants. Finally, the user can left-click on the check box next to "Turn off Wizard Mode." This will turn off Wizard Mode until such time as Wizard Mode is turned back on, by way of the tools menu in the Main Window.

iv. Help Resources

The Help menu found on the Main Window of the Application provides the Application user with ready access to this software instruction Comet Manual. It also provides access to an "About" feature which lists the Application Software version number, Copyright information and a contact link to Trevigen’s Website.

IX. END USER LICENSE AGREEMENT FOR TREVIGEN INC.

IMPORTANT: READ THIS END USER LICENSE AGREEMENT (THIS “CONTRACT”) CAREFULLY. IF YOU INSTALL OR USE ANY SOFTWARE PRODUCT THAT ACCOMPANIES OR IS ASSOCIATED WITH THIS CONTRACT (THE “SOFTWARE”), THIS CONTRACT WILL BECOME A LEGALLY BINDING AGREEMENT BETWEEN YOU AND TREVIGEN INCORPORATED (“TREVIGEN”). IF YOU DO NOT AGREE TO OR WISH TO BE BOUND BY THIS CONTRACT, DO NOT INSTALL OR USE THE SOFTWARE AND RETURN IT FOR A REFUND WITHIN 30 DAYS OF THE DATE THAT YOU PAID FOR THE SOFTWARE. PLEASE SEE TREVIGEN’S RETURN POLICIES SET FORTH AT WWW.TREVIGEN.COM FOR INFORMATION ABOUT HOW TO RETURN THE SOFTWARE FOR A REFUND.

THIS CONTRACT REQUIRES THE BINDING ARBITRATION OF ANY AND ALL DISPUTES (OTHER THAN CERTAIN SPECIFIED INTELLECTUAL PROPERTY CLAIMS AND SMALL CLAIMS), AS STATED IN THE “RESOLUTION OF DISPUTES” SECTION (PARAGRAPH 13) BELOW, WHICH YOU SHOULD READ IN ITS ENTIRETY. YOU UNDERSTAND THAT THIS IS A LEGALLY BINDING INSTRUMENT AND AGREE TO ABIDE BY ITS TERMS.

THIS CONTRACT APPLIES TO YOU AND ANY AND ALL PERSONS THAT YOU PERMIT TO INSTALL OR USE THE SOFTWARE, INCLUDING BUT NOT LIMITED TO THE FAMILY MEMBERS OR ANY OTHER USERS AS SET FORTH IN PARAGRAPH 2 OF THIS CONTRACT BELOW.

1. THE SOFTWARE; OWNERSHIP; THIRD PARTY MATERIALS
(a) Components, software, data, files, documentation, code, content and other materials ("Components") that are supplied to you with or generated by or through the use of the Software are part of the Software, and are encompassed by any reference in this Contract to the Software, except as stated in paragraph 1(c) below

(b) The Software is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. You are licensing the Software, not buying it. Trevigen retains ownership of all copies of the Software (including the copy(ies) provided to or made by you) and of all intellectual property rights in the Software.

(c) Components that are proprietary to Microsoft Corporation or other third parties (collectively, “Third Party Components”) may be provided to you by Trevigen along with or during the process of downloading or installing the Software, including any Updates (as defined below), or the Software may facilitate or arrange your acquisition of Third Party Components. If Trevigen provides Third Party Components to you, or if the Software facilitates or arranges your acquisition of Third Party Components (including but not limited to updates, upgrades, enhancements or new versions of Third Party Components already installed on your computer), in either case under a license or other grant of rights from that third party, then the Third Party Component is not part of the Software, and your rights and obligations with respect to those Third Party Components are as set forth in that third party license or other grant of rights. Of course, you should carefully read any such license or other grant of rights. Trevigen has no obligations to you whatsoever relating to any such Third Party Components.

(d) The network services, Third Party Components, or other software or products other than the Software upon which the Software’s performance depends might be interrupted or discontinued at the discretion of the suppliers (software suppliers, service providers, or Trevigen). Neither Trevigen nor its suppliers warrant that those software products, network services, or other products will continue to be available or that they will operate without interruption, modification, inaccuracy or error.

2. GRANT OF LICENSE
(a) Trevigen grants you a limited, personal, non-transferable, nonexclusive and revocable license to use the Software in compliance with this Contract. You are not licensed or otherwise authorized to use the Software in any way that violates this Contract. If you violate this Contract, your right to use the Software will automatically and immediately terminate, without notice. Upon termination of your right to use the Software, you must immediately cease all use of the Software.

(b) You may use the Software on only one computer except to the extent that paragraph 2(b)(ii), 2(b)(iii) or 2(b)(iv) below specifically authorizes you to allow the Software to be used on more than one computer.
(i) **License Documentation.**

"License Documentation" means a sales receipt, other document or written communication of any type (including, but not limited to, information provided or transmitted electronically) that Trevigen or an Trevigen authorized reseller, distributor or licensee provides to you when you purchase this license to use the Software.

(ii) **Commercial Multi-User Documentation.**

"Business" means a company, sole proprietorship, corporation, partnership, other business entity, charitable organization, governmental entity or school, university or other educational entity.

"Commercial Multi-User Documentation" means License Documentation that states that you are authorized to allow the Software to be used for commercial purposes on more than one computer. If you received and have retained Commercial Multi-User Documentation in connection with this Contract, you may allow the Software to be used on the number of computers specified in your Commercial Multi-User Documentation (or five (5) computers if no number of computers is specified on your Commercial Multi-User Documentation). Each of those computers must be owned and controlled by your Business and used primarily for business, governmental or charitable purposes in the conduct and operation of that Business.

(iii) **Family Users.**

Your “Significant Other” means your spouse or registered domestic partner or, if you are not married and have no registered domestic partner, then “Significant Other” may refer to the individual, if any, with whom you have a committed relationship that is substantially similar to marriage or registered domestic partnership.

“Family Member” means you, your Significant Other, and your or your Significant Other’s children, grandchildren, parents, grandparents and siblings, regardless of whether their relationship to you or your Significant Other is biological, step or adoptive.

Use of the Software for "Family Purposes" includes only use for personal or household purposes and specifically excludes any use for business, governmental or charitable purposes.

If you use the Software primarily for Family Purposes, then, except as otherwise provided in paragraph 2(b)(iv), you may allow the Software to be used on any computer that is both (i) owned and controlled by a Family Member whose primary residence is the same domicile as your primary residence and is the primary user of that computer and (ii) used by that Family Member primarily for Family Purposes. You have no rights under this paragraph 2(b)(iii) if you received any Commercial Multi-User Documentation in connection with this Contract or if you use the Software primarily for business, governmental or charitable purposes.

For avoidance of doubt, each individual may have only one primary residence, which will be determined for purposes of this Contract using the criteria and factors that are then used to determine primary residence for purposes related to United States income taxes.

(iv) **Personal Use License Documentation.**

If you received License Documentation other than Commercial Multi-User Documentation ("Personal Use License Documentation") in connection with this Contract, and such Personal Use License Documentation states a specific number of computers on which the Software may be used, then, notwithstanding Section 2(b)(iii), your rights under Section 2(b)(iii) are limited to a maximum of such specific number of computers. Hence, Personal Use License Documentation merely limits the maximum number of computers on which the Software may be used under Section 2(b)(iii) (if applicable). It does not allow use on any other computers. For example, if there are ten computers in your home on which you would be permitted to install the Software under Section 2(b)(iii), but you purchased a license for the Software subject to Personal Use License Documentation that states that you may use the Software on up to three computers, then your rights are limited to use of the Software on three of those ten computers and on no other computers. Similarly, if there are only two computers in your home on which you would be permitted to use the Software under Section 2(b)(iii) and you purchased a license for the Software subject to Personal Use License Documentation that states that you may use the Software on up to three computers, then your rights are nevertheless limited to use of the Software on those two computers and on no other computers.

(c) “Other User” means anyone other than you that you rightfully allow to use the Software under paragraph 2(b) above. You are responsible to ensure that all Other Users comply with this Contract. Any violation of this Contract by any Other User will be deemed to be a violation by you. As a result, (i) your liability to Trevigen for any violation of this Contract by any Other User will be the same as your liability would have been if you had committed the violation yourself and (ii) if any Other User violates this Contract, your right to use the Software will automatically and immediately terminate, without notice. If your right to use the Software terminates for any reason, then the right of all Other Users to use the Software immediately and automatically terminates, without notice. If any Other User ceases to qualify as an Other User (for example, if the Other User ceases to be your Family Member or moves away from your primary residence), he or she must cease all use of the Software. Similarly, if any computer ceases to qualify as a computer on which you may allow the Software to be used under paragraph 2(b) above, all use of the Software on that computer must cease and all copies of the Software on the hard drive or other fixed storage medium of that computer must be deleted or uninstalled.

(d) The right under this Contract to use the Software on a computer includes the right to install the Software on the hard disk or other fixed storage medium of that computer and to copy the Software or parts of the Software onto the random access memory of that computer as necessary to enable the Software’s use on that computer. However, you understand that the Software is deemed to be used on any computer that accesses or benefits from the Software through a local area or other network (including the Internet) or by any other means, whether or not the Software is installed or copied onto the hard disk, other fixed storage medium
or random access memory of that computer. Thus, if all or part of the Software is installed on the hard disk or other fixed storage device of a computer, is at any time copied onto the random access memory of that computer, or is at any time accessible by that computer over any network or other connection or communication mechanism, you must be authorized to use the Software on that computer or to allow the Software to be used by an Other User on that Computer. Similarly, you may not use the Software to affect or act upon a component (such as a hard drive) of any computer on which you are not authorized to use the Software, including, for example, by attaching or connecting that component or computer to any computer on which the Software is installed or from which it is accessible.

(e) Trevigen grants you the right to make a back-up copy of the Software. The back-up copy may be used only if an authorized installed copy of the Software becomes unusable. The back-up copy must include all proprietary rights notices appearing on the original and must remain in your possession and control. Other Users are not allowed to make back-up copies.

(f) If you receive the Software from Trevigen or a Trevigen authorized reseller or distributor for no charge, then you may use the Software for Family Purposes only unless a sales receipt or other document that Trevigen or an Trevigen authorized reseller or distributor provides to you states that you may use the Software for purposes other than Family Purposes.

(g) Except as specifically permitted in this Contract, you may not (i) copy the Software, (ii) modify or translate the Software or separate out any of its components for use with other software (except to the extent contemplated in the associated user documentation provided by Trevigen), (iii) use the Software to provide time sharing, service bureau, application service provider or similar services, (iv) tamper or in any way interfere with the operation of the Software or any related service, including by making any efforts to defeat any copy-protection or other digital rights management device or technology used by Trevigen in connection with the Software or any related service or (v) decompile, disassemble, or otherwise reverse engineer or discover or reveal the source code for the Software. Further, you may not allow, encourage, motivate or assist anyone to do anything that this Contract prohibits you from doing. Your only rights that relate to the Software are the rights clearly stated in this Contract. Trevigen retains all other rights that relate to the Software.

3. U.S. GOVERNMENT RESTRICTED RIGHTS

The Software is provided with RESTRICTED RIGHTS. Any use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c) (1) and (2) of the Commercial Computer Software – Restricted Rights at 48 CFR 52.227-19, as applicable. The manufacturer is Trevigen Inc, 8405 Helgerman Ct., Gaithersburg, MD 20877 USA

4. DISCLAIMER OF WARRANTIES

(a) You acknowledge and agree that use of the Software is at your sole risk. To the maximum extent allowed under applicable law, the Software and all maintenance, support or other services that relate in any way to the Software are provided “AS IS” without warranty of any kind, and Trevigen, its affiliates and their respective licensors, suppliers and service providers expressly disclaim all warranties, express or implied, including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose, title and non-infringement. The duration of any implied warranty that is not effectively disclaimed will be limited to the longer of (i) thirty (30) days from the date that you pay for the Software and (ii) the shortest period allowed under applicable law. Some states / jurisdictions do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you.

(b) Without limiting the disclaimer provided in paragraph 4(a) above, Trevigen does not warrant that the functions contained in the Software will meet your requirements or that the operation of the Software will be uninterrupted or error-free or that errors or specification non-conformities in the Software will be corrected. Further, Trevigen does not warrant or make any representations regarding the use or the results of the use of the Software, including, but not limited to, (i) whether the Software or its use will harm, impair or damage any hardware, software or data or (ii) the Software’s correctness, accuracy or reliability. No oral or written information or advice given before or after the date of this Contract by Trevigen, any authorized representative of Trevigen or any other person will create or be deemed to be any warranty with respect to the Software or any maintenance, support or other services that relate in any way to the Software. If the Software malfunctions or the Software or any such services are defective in any way, you (and not Trevigen) assume the entire cost and risk of all necessary servicing, repair, replacement or correction of the Software or of any other software, data, hardware, equipment or component that is damaged or destroyed as a result of that malfunction or defect.

(c) Trevigen strongly recommends that you perform a virus and malware check of all software before installation or use and that you back up your important files and data frequently.

5. LIMITATION OF LIABILITY

(a) To the maximum extent permitted by applicable law, neither Trevigen nor its affiliates nor its or its affiliates’ licensors, suppliers or service providers nor any of their respective officers, directors, owners, employees, agents, suppliers or representatives (collectively, the “Trevigen Parties”) will be liable for any special, incidental, consequential or exemplary damages, including, but not limited to, damages for loss of use, lost profits or loss of data or information of any kind, arising out of or in connection with (i) the Software or its use, (ii) any maintenance, support or other services that relate in any way to the Software or (iii) this Contract, even if any Trevigen Party has been advised of the possibility of such damages.
(b) To the maximum extent permitted by applicable law, in no event will the aggregate liability of the Trevigen Parties’ for any claims relating to the Software or its use, to any maintenance, support or other services that relate in any way to the Software, or to this Contract, whether sounding in contract, tort or any other theory of liability, exceed, in the aggregate for all claims, the liability cap specified in paragraph 5(b)(i) below or paragraph 5(b)(ii) below.

(i) Preloaded or Bundled Software.

If you receive the Software from Trevigen or an Trevigen authorized reseller or distributor preloaded on a computer or otherwise in a transaction that includes both the Software and hardware, equipment, data, other software or services (the “Bundled Components”) and a single fee charged to you covers both the Software and some or all of the Bundled Components, so that you do not pay a separate fee that is attributable only to your license of the Software, then the liability cap will be five dollars ($5). However, (i) maintenance, support or other services generally provided with the Software for no additional charge are not Bundled Components and are treated as part of the Software for purposes of this paragraph, and (ii) this paragraph 5(b)(i) does not apply if all of the Bundled Components you receive with the Software are generally available for no charge or if you receive the Software from Trevigen or an Trevigen authorized reseller or distributor for no charge.

(ii) Standalone Software or No-Charge Software.

If paragraph 5(b)(i) above does not apply to you, then the liability cap will be the greater of (i) the license fee you paid for the Software or (ii) one dollar (U.S.$1.00). Some states / jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.

6. TRANSFER

You do not have the right to (i) assign, sell or otherwise transfer your license under this Contract, (ii) grant any sublicense under that license or (iii) distribute, transmit, lease, sell or rent the Software to any other person.

7. UPDATES

After you first install the Software, Trevigen may from time to time provide you with (or make available to you) updates, patches, error corrections, Components or new or modified versions for or of the Software (collectively, “Updates”). If Trevigen provides you with any Update or makes any Update available to you, then it will be deemed part of the Software subject to this Contract (unless it is a Third Party Component excluded from the Software under paragraph 1(c) above). Updates may be transmitted to your computer over the Internet or other network and installed on your computer, with or without notice to you and with or without your consent. You acknowledge and agree that nothing in this Contract obligates Trevigen to create any Updates. Further, even if Trevigen does create any Updates, nothing in this Contract obligates Trevigen to provide or make available to you any of those Updates, except as provided in paragraph 8 below.

8. MAINTENANCE

Trevigen’s service of providing Updates (or making Updates available) to users of the Software is called “Maintenance” or “Service” with respect to the Software. You may be entitled to receive Maintenance (and hence receive or have access to any generally released Updates, subject to any requirement to accept a new end user license or amendments to this Contract as discussed below in this paragraph 8) for a limited period of time after you license the Software to the extent specified on the packaging for the Software, materials included in that packaging, your sales receipt, Trevigen’s Web Site or other materials provided to you by Trevigen or an authorized resellers or distributors that relate to your license or download of the Software. Trevigen may, but is not obligated to, offer to renew or extend your period of Maintenance for the Software, for a fee, at Trevigen’s Web Site or by other means. You acknowledge and agree that (i) Updates may delete or change features or other aspects of the Software, including functions you may rely upon; (ii) certain Updates may be necessary to allow you to continue to use some or all of the features of the Software, so the Software may not be useful to you without Maintenance; and (iii) although (except as stated above) you will be entitled during your period of Maintenance to receive any Updates that Trevigen creates and generally releases to its customers who then have Maintenance, nothing obligates Trevigen to create or generally release any Updates at any time, including, but not limited to, during your period of Maintenance. You further acknowledge and agree that, (i) if your period of Maintenance terminates or is interrupted, you may not be eligible to renew Maintenance, and (ii) you may be required to accept a new end user license agreement (to be used in lieu of this Contract) or changes or amendments to this Contract as a condition to your renewal of Maintenance or to receiving or using any Update. Finally, if you purchase “lifetime” Maintenance, your lifetime Maintenance will apply only to your use of the Software on computers on which you rightfully install the Software during the one (1) year period after you first license the Software. The lifetime Maintenance will continue for as long as you continue to use those computers, but not longer than their industry-standard useful life. Such lifetime Maintenance will not apply to any other computers. Thus, transferring any copy of the Software to another computer will terminate your right to receive Maintenance for that copy. Further, your right to continue to receive Maintenance will be subject to meeting Trevigen’s then-current eligibility requirements, including, but not limited to, the requirement that you use a version of Windows that Trevigen then supports. Notwithstanding the foregoing, your Maintenance will terminate at any time that Trevigen generally ceases to maintain and support the Software. You will be deemed to purchase lifetime Maintenance only if your purchase of a license to the Software is made subject to an offer that specifically states that the Software or related Maintenance is provided on a “lifetime” basis.

9. EXPORT

You acknowledge that the Software is subject to United States and other export control laws, including the export administration regulations. You will not export, re-export or divert the Software in contravention of those laws.
10. CHANGES

At the time that you license the Software, the Software may not include all (or may include different) functions and features than advertised. Functions and features are subject to further change without notice after you license and install the Software. You must accept all changes made to the Software, which may include the inability to continue using a feature or function if Trevigen elects in its sole discretion to discontinue it.

11. SEVERABILITY

If any part of this Contract is held invalid or unenforceable, the remaining parts of this Contract shall be unimpaired and remain in full force and effect. Further, if any part of this Contract is partially enforceable and partially unenforceable, that part shall be enforced to the maximum extent allowed under applicable law.

12. RESOLUTION OF DISPUTES: BINDING ARBITRATION; NO CLASS OR REPRESENTATIVE ACTIONS OR ARBITRATIONS

(a) Arbitration of Any And All Disputes (Other Than Certain Specified Intellectual Property Claims).

(i) “Dispute” as used in this paragraph 12 means any dispute arising out of or in any way related to this Contract, any amendments or addenda to this Contract, or the subject matter of this Contract, including but not limited to any contract, tort, statutory or equity claims that relate in any way to (1) this Contract, (2) the Software, (3) maintenance, support or other services that relate in any way to the Software, (4) the use, operation, licensing, distribution, sale, advertising, promotion, transmission, provision or marketing of the Software or such services, (5) any transaction that relates in any way to the Software or such services, (6) any claims, statements, promises, descriptions, representations or warranties made in connection with the Software, any such services or any such transaction, and (7) the use or disclosure of personal information obtained by Company in connection with the Software, any such transaction or any such services; provided, however, that any claims specifically described in paragraph 12(a)(viii) below will not be included in the definition of Dispute.

(ii) This paragraph 12 shall apply to the resolution of Disputes. In the event of any Dispute, the parties are encouraged to attempt to resolve the Dispute by informal means. If the parties are not able to do so, the Dispute will be resolved only by binding arbitration.

(iii) Arbitration is the referral of a dispute to one or more impartial persons for a final and binding determination. Any Dispute between Trevigen, on the one hand, and you and/or any Other User, on the other hand, will be subject to binding arbitration; provided, however, that you have the right to litigate any Dispute in small claims court, if all the requirements of the small claims court, including any limitations on jurisdiction and the amount at issue in the Dispute, are satisfied. You agree to bring a Dispute in small claims court only in your county of residence or Gaithersburg, Maryland.

(iv) The parties expressly agree that there shall be no jury trial or right to a jury trial, or right to any other proceeding to resolve any Dispute in any court. In the event of any Dispute, both parties agree that this Contract will be governed, both procedurally and substantively, by the Federal Arbitration Act, 9 U.S.C. sections 1-9 (“FAA”) to the maximum extent permitted by applicable law.

(v) All aspects of the arbitration proceeding, and any ruling, decision or award by the arbitrator, will be strictly confidential for the benefit of all parties, and any party shall have the right to prevent any actual or threatened breach of this confidentiality provision by temporary, preliminary or permanent injunctive or declaratory relief in an appropriate court of law.

(vi) The parties expressly agree that any Dispute is personal to them, and any such Dispute shall only be resolved by an individual arbitration. Neither party agrees to class arbitration, or an arbitration where a person brings a Dispute as a representative of any other person or persons. Neither party agrees that a Dispute can be brought as a class or representative action outside of arbitration, or on behalf of any other person or persons. The parties agree that that a Dispute may only be resolved through an individual arbitration and shall not be brought as a class arbitration, a class action, or any other representative proceeding.

(vii) The arbitration of the Dispute will be administered by the American Arbitration Association (“AAA”) or, in the event the AAA declines or is unable to administer the arbitration, by an arbitration forum or arbitrator that you and Trevigen mutually agree upon.

If, after making a reasonable effort, you and Trevigen are unable to agree upon an arbitration forum or arbitrator, the AAA or a court having proper jurisdiction will appoint an arbitration forum or arbitrator. The arbitration will be conducted in accordance with the AAA’s Commercial Arbitration Rules (“Commercial Rules”) and, when deemed appropriate by the arbitration forum or arbitrator, the AAA’s Supplementary Procedures for Consumer-Related Disputes (“Consumer Procedures”), or the appropriate rules of any alternative arbitration forum selected by you and Trevigen or appointed by a court, subject to the following modifications:

1. The arbitration will be conducted before a single arbitrator who will be a licensed attorney or a former judge and will have at least 10 years of legal experience in the resolution of commercial disputes.

2. As limited by the FAA, the terms of this Contract, and the applicable AAA rules, the arbitrator will have the exclusive power and jurisdiction to make all procedural and substantive decisions concerning the Dispute. This does not include the power to conduct a class arbitration or a representative action, which is prohibited by the terms of this Contract as stated above. The arbitrator may only conduct an individual arbitration, and may not consolidate more than one person’s claims and may not preside over any form of representative or class proceeding, or any proceeding on behalf of or involving more than one person or persons.
3. The parties may take discovery through interrogatories, depositions and requests for production that the arbitrator determines to be necessary, with the caveat that each party shall have the right to take the deposition of at least one person for at least one day.

4. In making any award, the arbitrator will be restricted by the Limitation of Liability provisions in this Contract (paragraph 5), and will not have jurisdiction to make an award to any party to the arbitration contrary to the Limitation of Liability provisions; provided however that if the enforceability of any of these restrictions is limited by the applicable substantive law or by the AAA rules, that restriction will only be enforced to the extent permitted by such law or rules.

5. The prevailing party in any of the following matters (without regard to the Limitation of Liability provisions) will be entitled to recover its reasonable attorneys’ fees and costs incurred: (i) a motion which any party is required to make in the courts to compel arbitration of a Dispute; (ii) any appeal of an arbitration award, whether to the arbitrator or the courts, for the purpose of vacating or modifying the award; or (iii) any action to enforce the confidentiality provisions stated herein.

6. Trevigen will pay the amount of any arbitration costs and fees charged by the AAA, subject to the right of Trevigen to request that the arbitrator allocate the ultimate responsibility for that fee in a fair and reasonable manner. Unless the arbitrator finds that you are economically unable to pay a share of the arbitrator’s fee or that it is otherwise inappropriate for you to do so, the arbitrator ultimately may decide that you are responsible for some portion of that fee in the arbitrator’s discretion.

The AAA rules are available from the AAA, which can be contacted by mail at 1633 Broadway, Floor 10, New York, New York 10019, by telephone at (800) 778-7879, or through its website at www.adr.org.

(viii) The following claims by you, any Other User or Trevigen shall not be subject to binding arbitration and shall not be submitted to arbitration: (1) claims of infringement or misappropriation of any United States or foreign copyright, patent, trade secret, trademark, service mark or trade dress and (2) claims alleging violations of Title 17 of the United States Code, Sections 1201 and/or 1202, or of any similar foreign law. For any claims not subject to binding arbitration, neither you nor Trevigen nor any Other User will be bound by any decision or award of any arbitrator in connection with the resolution or decision of any question of fact or law required to resolve such claim, including, but not limited to, questions required to decide or rule with respect to the infringement, misappropriation, validity, enforceability or ownership of any copyright, patent, trade secret, trademark, service mark or trade dress or with respect to any remedy or relief at law or in equity for any such infringement or misappropriation or for any violation of such Sections 1201 and/or 1202.

(b) With the exception of the provision above that the enforceability of this paragraph 13 of Resolution of Disputes is governed both procedurally and substantively by the FAA to the maximum extent permitted by applicable law, this Contract otherwise will be construed and enforced in accordance with the laws of the State of California and of the United States of America applicable to contracts entered into and performed in California to the maximum extent permitted by law.

13. LIMITATION OF TIME PERIOD TO COMMENCE ANY COMPLAINT OR ACTION

Regardless of any statute of limitations or law to the contrary, and to maximum extent permitted by applicable law, any claim or cause of action that constitutes a Dispute as defined in paragraph 12(a)(i) above must be filed within one (1) year after the date on which the incident giving rise to the Dispute occurred; provided that, if the substantive law applicable to the arbitration prohibits the parties from agreeing to this limitations period, then the limitations period under the applicable substantive law shall control. The failure of a party to file an arbitration claim within the applicable limitations period shall constitute a waiver by that party of its right to bring such a claim in any form, and a complete bar to any claim based on any Dispute, and the arbitrator shall not have jurisdiction to make a determination for a party that has not brought its claim within this applicable limitations period.

14. THIRD-PARTY BENEFICIARY

The Software may include computer programming code or other Components licensed by Trevigen from third parties. Those third parties are beneficiaries of, and will have the right to enforce against you, all of your obligations under this Contract to the extent that those obligations relate to any computer programming code or other Components of those third parties.

15. ENTIRE AGREEMENT; WAIVER

Except as expressly provided below, this Contract is the entire agreement between you and Trevigen relating to the subject matter of this Contract. It supersedes any prior oral or written communication and any contemporaneous oral communication relating to that subject matter. For avoidance of doubt, except as expressly provided in Section 2, no License Documentation shall be deemed to be a part of or incorporated into this Contract. Accordingly, no License Documentation shall be deemed to in any way amend, supplement or otherwise affect any provision of this Contract, other than as expressly contemplated in Section 2 with respect to the number of computers on which the Software may be used. This Contract may not be amended except as contemplated in paragraph 7 or paragraph 8 above or by a writing signed by you and an authorized representative of Trevigen. Further, there being no expectations to the contrary between you and Trevigen, no usage of trade or other regular practice or method of dealing between you and Trevigen will be used to modify, interpret, supplement or alter in any manner any express terms of this Contract. No waiver of any provision of this Contract or any rights or obligations of either you or Trevigen under this Contract will be effective, except when done in a writing signed by the party granting the waiver, and any waiver will be effective only in the specific instance and for the specific purpose stated in that writing.
QUESTIONS OR COMMENTS

Should you have any questions concerning this Contract, you may contact Trevigen in writing at:

Trevigen Inc.
8405 Helgerman Ct.,
Gaithersburg, MD 20877
USA

X. References

CometChip®

Standard CometAssay®
## XI. Troubleshooting for Software

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>CAUSE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows for Edit Mode, Review and Edit, Numeric Results or Search Images are not arranged properly on screen.</td>
<td>User has freedom to move and resize windows as needed. Windows open to previous location.</td>
<td>To open windows to default position select <strong>TOOLS &gt; Reset User Settings</strong> from Main Window.</td>
</tr>
<tr>
<td>&quot;Search Image&quot; window is not visible in &quot;Review and Edit&quot;.</td>
<td>&quot;Search Image&quot; window does not open automatically in &quot;Review and Edit&quot;.</td>
<td>To open window select <strong>WINDOWS &gt; Activate Search Images</strong> from Main Window.</td>
</tr>
<tr>
<td>Software is not calling end of head properly. Density profiles places marker either in middle of head or toward end of tail.</td>
<td>Incomplete DNA staining of internal region of comet head appears as donut. Density profile shows to peaks in head region.</td>
<td>Stain for 1 hr with 0.1X SYBR Gold.</td>
</tr>
</tbody>
</table>
# XII. Related Products Available From Trevigen

## CometAssay® Standardized System

<table>
<thead>
<tr>
<th>Instrumentation</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CometAssay® Electrophoresis System II</td>
<td>4250-050-ES</td>
</tr>
<tr>
<td>CometAssay® 2 Well ES Unit w/ Starter Kit</td>
<td>4250-050-ESK</td>
</tr>
<tr>
<td>CometAssay® 2 Well ES Unit w/ Starter Kit and Power Supply for North America</td>
<td>4250-050-ESK-PS1</td>
</tr>
<tr>
<td>CometAssay® 20 Well ES Unit w/ Starter Kit</td>
<td>4252-040-ESK</td>
</tr>
<tr>
<td>CometAssay® 20 Well ES Unit w/ Starter Kit and Power Supply for North America</td>
<td>4252-040-ESK-PS1</td>
</tr>
<tr>
<td>CometAssay® 96 Well ES Unit w/ Starter Kit and Power Supply for North America</td>
<td>4253-096-ESK-PS1</td>
</tr>
</tbody>
</table>

#### Reagent Kits

<table>
<thead>
<tr>
<th>Size</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CometAssay® Kit (25 X 2 well slides)</td>
<td>4250-050-K</td>
</tr>
<tr>
<td>CometAssay® Kit (2 X 20 well slides)</td>
<td>4252-040-K</td>
</tr>
<tr>
<td>CometAssay® Kit (1 X 96 well slide)</td>
<td>4253-096-K</td>
</tr>
</tbody>
</table>

#### Reagents

<table>
<thead>
<tr>
<th>Size</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CometAssay® Lysis Solution</td>
<td>4250-010-01</td>
</tr>
<tr>
<td>CometAssay® Lysis Solution</td>
<td>4250-050-01</td>
</tr>
<tr>
<td>CometAssay® LMAgarose</td>
<td>4250-050-02</td>
</tr>
<tr>
<td>CometAssay® LMAgarose</td>
<td>4250-500-02</td>
</tr>
</tbody>
</table>

#### Control Cells

<table>
<thead>
<tr>
<th>Size</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CometAssay® Alkaline Control Cells</td>
<td>4256-010-CC</td>
</tr>
<tr>
<td>CometAssay® Neutral Control Cells</td>
<td>4257-010-NC</td>
</tr>
</tbody>
</table>

#### Slides and Rack System

<table>
<thead>
<tr>
<th>Size</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLARE™ Slides (3 Well, 25 Slides)</td>
<td>3950-075-02</td>
</tr>
<tr>
<td>FLARE™ Slides (3 Well, 100 Slides)</td>
<td>3950-300-02</td>
</tr>
<tr>
<td>CometSlide™ (2 Well, 2 Slides)</td>
<td>4250-050-03</td>
</tr>
<tr>
<td>CometSlides™ (2 Well, 25 Slides)</td>
<td>4250-200-03</td>
</tr>
<tr>
<td>CometAssay® HT Slides (20 Well, 2 Slides)</td>
<td>4252-040-01</td>
</tr>
<tr>
<td>CometAssay® HT (20 Well, 10 Slides)</td>
<td>4252-200-01</td>
</tr>
<tr>
<td>CometAssay® HT (20 Well, 25 Slides)</td>
<td>4252-500-01</td>
</tr>
<tr>
<td>CometAssay® HT Slides (20 Well, 100 Slides)</td>
<td>4252-02K-01</td>
</tr>
<tr>
<td>CometSlide™ (96 Well)</td>
<td>4253-096-03</td>
</tr>
<tr>
<td>CometSlide™ Rack System (for 2, 3 and 20 well slides)</td>
<td>4252-040-02</td>
</tr>
</tbody>
</table>

#### FLARE™ Assay Kits and Modules

<table>
<thead>
<tr>
<th>Size</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLARE™ Sample Prep</td>
<td>3950-075-SP</td>
</tr>
<tr>
<td>Fpg FLARE™ Assay Kit</td>
<td>4040-100-FK</td>
</tr>
<tr>
<td>Fpg FLARE™ Module</td>
<td>4040-100-FM</td>
</tr>
<tr>
<td>E. coli Endonuclease III FLARE™ Kit</td>
<td>4045-01K-FK</td>
</tr>
<tr>
<td>E. coli Endonuclease III FLARE™ Module</td>
<td>4045-01K-FM</td>
</tr>
<tr>
<td>hOGG1 FLARE™ Assay Kit</td>
<td>4130-100-FK</td>
</tr>
<tr>
<td>hOGG1 FLARE™ Module</td>
<td>4130-100-FM</td>
</tr>
</tbody>
</table>

## CometChip® High throughput System

<table>
<thead>
<tr>
<th>Size</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CometChip® (30 micron pores)</td>
<td>4260-096-01</td>
</tr>
<tr>
<td>CometChip® Kit</td>
<td>4260-096-K</td>
</tr>
<tr>
<td>96-Well CometChip® System</td>
<td>4260-096-CS</td>
</tr>
<tr>
<td>CometChip® Electrophoresis Starter Kit</td>
<td>4260-096-ESK</td>
</tr>
<tr>
<td>CometChip® Electrophoresis Starter Kit and PS for NA</td>
<td>4260-096-ESK-PS1</td>
</tr>
</tbody>
</table>
XIII. Appendix

Appendix A: Range and Default Values for Protocol Parameters

- **CometBoxHeight**
  - Range: Depends on image scale (2 – 3 times typical undamaged head diameter)
  - Default: 2.3 times typical undamaged head diameter

- **CometBoxWidth**
  - Range: Depends on image scale (3 – 5 times typical undamaged head diameter)
  - Default: 4 times typical undamaged head diameter

- **MaximumCellColumns**
  - Range: Depends on image scale (0.9 – 1.0 times CometBoxWidth)
  - Default: 0.9 times CometBoxWidth

- **MaximumCellRows**
  - Range: Depends on image scale (0.8 – 1.0 times CometBoxHeight)
  - Default: 0.8 times CometBoxHeight

- **MinColsToRowsRatio**
  - Range: 0.5 – 1.0
  - Default: 0.7

- **MinimumCellColumns**
  - Range: Depends on image scale (0.1 – 0.4 times typical head diameter)
  - Default: 0.3 times typical head diameter

- **MinimumCellRows**
  - Range: Depends on image scale (0.1 – 0.4 times typical head diameter)
  - Default: 0.3 times typical head diameter

- **PercentCutoff**
  - Range: 0.5 - 5
  - Default: 4

- **PotentialCellMaxCutoff**
  - Range: 245 - 255
  - Default: 255

- **PotentialCellMinCutoff**
  - Range: 5 – 20
  - Default: 8

- **SymmetryPercentTolerance**
  - Range: 10 - 35
  - Default: 25

- **SymmetryStdDeviation**
  - Range: 1 - 4
  - Default: 2

- **TailAsymmetricPercent**
  - Range: 20 - 50
  - Default: 40
Appendix B: Comparison Data

Trevigen® Comet Analysis System

- Automatic Comet finding and scoring.
- No need to manually identify each comet.
- Easy to use and intuitive software.
- 4X images require fewer images to be captured.
- 150 comets per one 4X image.
- No over lapping comets results in minimal editing.
- Easily processed data exports.
- Scan 96 well CometChip® in 10-15 minutes. Competitive software requires minimally 10 minutes per well or 960 minutes or 16 hours.

Software Validation Using Simulated Comets

Simulated Comets

- The simulated comet images were designed to represent a range of damage levels and were constructed by using solid circular and elliptical shapes of selected intensity (grey scale) values to mimic the basic shapes and intensities of typical comets.
- These comet images were then convolved with a 15 X 15 smoothing filter to make the appearance of the simulated comets more realistic.
- These simulated comets were then arrayed in a single image in an arrangement that would make their order of processing by the program predictable (for comparison purposes.)
Excellent Correlation Between Expected and Program Generated Analysis of Simulated Comets

Comparison of 4X vs 10X images in Neutral Comet Assays

- Jurkat Cells treated with increasing concentrations of Bleomycin
- Images were acquired with 4X and 10X objectives.
- 10X images were analyzed using Loats Automatic Comet Work Station.
- 4X images were analyzed using Trevigen Comet Analysis System (TCAS).

<table>
<thead>
<tr>
<th>Bleomycin</th>
<th>% counted (x100)</th>
<th>% DNA in Tail</th>
<th>Length</th>
<th>Moment</th>
</tr>
</thead>
<tbody>
<tr>
<td>ug/ml</td>
<td>4X</td>
<td>10X</td>
<td>4X</td>
<td>10X</td>
</tr>
<tr>
<td>0</td>
<td>164.50</td>
<td>116.50</td>
<td>14.96</td>
<td>17.41</td>
</tr>
<tr>
<td>20</td>
<td>152.50</td>
<td>85.50</td>
<td>19.24</td>
<td>21.55</td>
</tr>
<tr>
<td>200</td>
<td>153.50</td>
<td>101.00</td>
<td>29.93</td>
<td>32.46</td>
</tr>
<tr>
<td>1000</td>
<td>129.50</td>
<td>54.50</td>
<td>43.31</td>
<td>46.57</td>
</tr>
</tbody>
</table>
Comparison of 4X vs 10X images in Neutral Comet Assays

![Graphs showing % DNA in Tail, Tail length, and Moment](image)

Trevigen Analysis System Provide Comparable Results for 4x and 10X Images

- Trevigen Alkaline control cells on a 20 well slide.
- Cells treated with increasing levels of Hydrogen Peroxide (4 treatments.)
- Each treatment was analyzed in 5 wells.
- Images were acquired with 4X and 10X objectives.
- 10X images were analyzed using LoaSts Automatic Comet Work Station and Trevigen Software.
- 4X images were analyzed using Trevigen Comet Analysis System (TCAS).

<table>
<thead>
<tr>
<th>% DNA in Tail</th>
<th>Length</th>
<th>Moment</th>
</tr>
</thead>
<tbody>
<tr>
<td>% DNA</td>
<td>10X</td>
<td>40X</td>
</tr>
<tr>
<td>-----------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>0.22</td>
<td>2.68</td>
<td>1.00</td>
</tr>
<tr>
<td>11.50</td>
<td>37.82</td>
<td>26.38</td>
</tr>
<tr>
<td>25.80</td>
<td>42.42</td>
<td>28.09</td>
</tr>
<tr>
<td>35.83</td>
<td>44.54</td>
<td>38.41</td>
</tr>
</tbody>
</table>
The product accompanying this document is intended for research use only and is not intended for diagnostic purposes or for use in humans.

**Trevigen, Inc.**
8405 Helgerman Ct. Gaithersburg, MD 20877
Tel: 1-800-873-8443 • 301-216-2800
Fax: 301-560-4973
e-mail: info@trevigen.com
[www.trevigen.com](http://www.trevigen.com)